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PREFACE 

 

INTRODUCTION TO COMPUTER 

Information in this document is subject to change without notice and does not 
represent a commitment  that all one needs to know about computers is in this 

document.  The software, hardware and database described in this document  are  
organized as a comprehensive reference and arranged by task.  They include 

information for users who have little experience with computer systems.  Those who 
are familiar with computer operations may still find it necessary to read though this 
document.  Consult the table to learn how to use the commands you work with most 

often. 
 

This document is divided into the following parts: Computer concepts; Types of 
computers; Categories of computer systems; Storage devices and media; 

Programming methods for programme; Application software: a word 
processor, spreadsheets, interactive computing and networks, program, 

programming, programming languages; Role of computer in agriculture; 
Computer viruses 

This document contains reading materials for first year and second year students at 
the University. Specifically, it caters for students enrolled in ODeL mode and 
would like to access learning materials either online or purchase hard copies 
for use in the course. 
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INTRODUCTION 

The module “Introduction to Computers” aims to give general overview of what a  

Computer is and lay foundation of the science of computing.. 

The course contents examines the internal organization of the computer system which 

include CPU elements, memory, internal storage, and input/output units, CPU 

functionality and concepts, the CPU terminology, memory functionality, trend and  

concepts, RAM and ROM, External Storage (floppy and hard disk storage), monitor 

and their controllers (video graphic, driver software et cetera, Knowledge of internal 

data representation (number systems, base system, data organization-bit, byte, word et 

cetera), problem solving techniques, algorithms, syntax, data expression types, 

overview of operating systems, database systems, webserver properties and internet 

and human computer interaction. 

Course Objectives 

By the end of the course the learner should be able to: 

1. Have a general overview of computer system, which includes the fundamental 

components for computer system; hardware and software; 

2. A broad overview of the field of computer science and include a fundamental 

and topical issues in computer science;  

3. Programme using programming languages; 

4. Learn how an operating system interfaces the hardware resources with user’s 

environment;  

5. Provide fundamental concepts of database;  

6. Develop internet and web applications  
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The course requires that you  organize yourself to do private studies and make use of 

the library.  You are therefore expected to make timetable for self study and prepare 

to occasionally come for limited face to face interaction with the lecturer. You are 

also encouraged to form study groups with your colleagues.  Class assignments will 

be given with timelines and during the face to face interaction with the lecturer. You 

may be required to use the computer laboratory to do some assignments.  The key 

reference text for the module is “ Gary B. Shelly, Steve M. Freud and Misty 

Evermont, 2010. Introduction to Computers (Shelly Cashman Series); and Peter 

Norton (2004) Introduction to computers.” 

Awarding of marks and grading system: 

Continuous assessment and final examination shall be awarded marks as             

follows: 

                         Continuous Assessment                                  30%  

                          Final Examination                                           70% 

                           Total                                                               100% 

Marks should be translated into the following letter grades: 

                            70%   and above         A          Distinction 

                            60%--------69%           B           Credit 

                             50%-------59%            C           Satisfaction 

                              40%-------49%            D            Pass 

                              39%-and below            F             Fail 

The pass mark shall be 40% of  the full mark (100%).                                                                 
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LECTURE ONE 

COMPUTER CONCEPTS AND THEIR APPLICATIONS 

Lecture Outline 

1.1. Introduction  

1.2. Objectives 

1.3. Computer Carts  

1.4. Computer  Functions 

1.5. Application of Computer, Advantages and Disadvantages  

1.6. DOS, Windows, File and Extension Programs 

1.7. Summary 

1.8. Model Exam Questions 

1.9. Further Readings 

 

1.1 Introduction and Definition of Computer 

The 20th century saw the birth of one of the most important tools widely in use today 

called a computer. Today, computers are used for communication, management, research, 

drawing and design as well as entertainment. 

 

This 21st century is being referred to as the digital age  

 

A computer is an electronic device that accepts user input (data) and processes it under 

the influence of a set of instructions referred to as programs to produce the desired output 

generally referred to as information. 

• Data are the raw facts may not make much meaning to the user. 

• Programs are set of instructions that instruct a computer what to do. 

• Information is result after data has been processed. 
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1.2  Objectives 

By the end of this lecture, you should be able to: 

1. Identify and name computer parts 

2. Define basic concepts used in computer 

3. Explain applications of computers 

4. Discuss advantages & disadvantages of computers 

5. Practice the DOS, Windows, File and Extension programs with 

computers   

 

1.3 Computer Parts 

There are 4 basic types of computer parts:  

a) Input devices - parts of the computer that allow information or data to be given to 

the computer like keyboard or a mouse.  

b) Storage devices – parts of the computer that hold information.  The primary 

storage device is the computer’s memory called RAM (random access memory).  

It remembers everything that is read, input, or output.  But, because the 

computer’s memory is on a temporary area—it forgets everything when turned 

off—it must have another place to store information permanently.  This secondary 

storage device is usually a disk. 

c) Processing device – part of the computer that processes and controls the flow of 

information; it actually does the work.  The one part of the computer that handles 

this job is the central processing unit or CPU.  

d) Output devices - parts of the computer that gives out information generated by the 

computer, like a monitor, printer or speaker.  
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Input – Process - Output 

 

 

1.4 Computers and their Functions 

Computer - An electronic device that receives data and computes high-speed 

mathematical or logical operations or that assembles, stores, correlates, or otherwise 

processes and presents information. 

 

A computer has four functions: 

The Information Processing Cycle 

accepts data Input 

 

processes data Processing 

Produces output Output 

Stores results Storage 

Fundamentals of Computing 
4 

Input (Data) 
Process 

Output 

(Information) 

Keyboard, digital 

camera, scanner etc. 

Central processing 

unit (CPU) 

Monitor,  printer, 

speakers etc. 



 5

What makes a computer powerful? 

 Speed A computer can do billions of actions per second. 

 Reliability Failures are usually due to human error, one way or another. (Blush 

for us all!) 

 Storage A computer can keep huge amounts of data. 

   

Glossary of Basic Concepts 

GUI – A Graphical User Interface – which uses visual displays to eliminate the need for 

typing commands. 

 

Formatting – The process of preparing a disc so that it can store information. During 

formatting, sectors, tracks, a director and the FAT are created on the disc. 

Sector – disc space normally 512 bytes long. 

Track – A track is also a data storage ring on a computer floppy diskette or 

hard disk drive that is capable of containing information. a track goes all 

around the platter and is used to help locate and retrieve information from 

a disk or diskette. 

Directory- an area on disc where information relating to a group of files is 

kept.  

FAT – the File Allocation Table – an area on disc where information is 

kept on which part of the disc the file is to be found. 

Directory tree – a pictorial representation of your disc’s structure. 

Boot – to start up the computer and load the DOS. 

BIOS – The BASIC Input/Output System. It allows the core of the operating 

system to communicate with the hardware. 

Bit – a binary digit, the smallest unit of information that can be stores either as 1 

or 0. 

Byte – a grouping of binary digits (0 or 1) which represent information. 
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CPU – the Central Processing Unit – the main chip that executes all commands. 

Disc – a device which you can store programs and data 

Cold boot – the process of starting your PC by switching it on. 

Warm boot - the process of starting your PC by using the Ctrl+Alt+Del key 

combination. 

File – the name given to an area on disc containing a program or data. 

Filename – the name given to a file. It must not exceed 8-characters in length and 

can have up to 3-characters. 

File extension – the optional three-letter suffix following the period in a filename. 

Processor – The electronic device which performs calculations. 

Prompt – A symbol that appears on a monitor to indicate that DOS is ready to 

receive input or commands, such as A> or C>. 

Peripheral – A device attached to a PC. 

Path – The drive and directories that DOS should look in for files. A path tells 

DOS how to locate a file within the directory structure. E.g. 

C:\SPREADSH\SSFILES\SALARY.TMP 

Port – an Input/Output address through which your PC interacts with external 

devices. 

Program – a set of instructions which cause a computer to perform certain tasks. 

Hardcopy – Output on paper 

Hardware – the visible, tangible equipment that makes up a computer system. 
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Software – the non- visible, non-tangible programs and instructions that control 

your PC’s functionality 

Root directory – The main disc directory under which a number of sub-directories 

can be created. 

ROM – Read Only Memory – the microcomputer’s non-volatile memory. Data are 

written into this memory at manufacture and are not affected by power loss. 

RAM – Random Access Memory – the microcomputer’s volatile memory. Data 

held in it is lost when power is switched off. 

Memory – Storage elements organized into addressable locations that can hold 

data and instructions in a PC. 

Megabyte – MB – 1024 kilobytes of information or storage space. 

Megahertz – MHz – Speed of processor in million of cycles/second. 

Mouse – a devise used to manipulate a pointer around the display. 

Monitor – the display devices connected to a PC. Also known as the Screen, 

VDU. 

Microprocessor – A PC’s calculating chip. 

Multitasking – Running more than one computer application at the same time. An 

operating system that permits multitasking allows the user to be printing a 

document from one program while working in another, as well as downloading 

content from the Internet in the background. 

Backbone - A cable to which multiple nodes or workstations are attached.  

Bit - Binary digit in the binary numbering system. Its value can be 0 or 1. In an 8-bit 

character scheme, it takes 8 bits to make a byte (character) of data.  
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Client/Server - A networking system in which one or more file servers (Server) provide 

services; such as network management, application and centralized data storage for 

workstations (Clients).  

Hub - A hardware device that contains multiple independent but connected modules of 

network and internetwork equipment. Hubs can be active (where they repeat signals sent 

through them) or passive (where they do not repeat but merely split signals sent through 

them). 

Infrared - Electromagnetic waves whose frequency range is above that of microwaves, 

but below that of the visible spectrum.  

Intranet - Network internal to an organization that uses Internet protocols. 

Internet - A global network of networks used to exchange information using the TCP/IP 

protocol. It allows for electronic mail and the accessing ad retrieval of information from 

remote sources.  

LAN (Local Area Network) - A network connecting computers in a relatively small area 

such as a building.  

MAN (Metropolitan Area Network) - A network connecting computers over a large 

geographical area, such as a city or school district.  

Modem (Modulator/Demodulator) - Devices that convert digital and analog signals. 

Modems allow computer data (digital) to be transmitted over voice-grade telephone lines 

(analog). 

Multiplexer - A device that allows multiple logical signals to be transmitted 

simultaneously across a single physical channel. 

Network Modem - A modem connected to a Local Area Network (LAN) that is accessible 

from any workstation on the network.  
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Network Interface Card (NIC) - A board that provides network communication 

capabilities to and from a computer. 

Network Operating System (NOS) - Operating system designed to pass information and 

communicate between more than one computer. Examples include AppleShare, Novell 

NetWare, and Windows NT Server.  

Node - End point of a network connection. Nodes include any device attached to a 

network such as file servers, printers, or workstations.  

Node Devices - Any computer or peripheral that is connected to the network.  

Peer-to-Peer Network - A network in which resources and files are shared without a 

centralized management source. 

Physical Topology - The physical layout of the network; how the cables are arranged; and 

how the computers are connected. 

Point-to-Point - A direct link between two objects in a network. 

Ports - A connection point for a cable. 

Protocol -A formal description of a set of rules and conventions that govern how devices 

on a network exchange information.  

Repeater - A device used in a network to strengthen a signal as it is passed along the 

network cable. 

Star Topology - LAN topology in which each node on a network is connected directly to 

a central network hub or concentrator.  

Star-Wired Ring - Network topology that connects network devices (such as computers 

and printers) in a complete circle.  
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Topology - There are two types of topology: physical and logical. The physical topology 

of a network refers to the configuration of cables, computers, and other peripherals. 

Logical topology is the method used to pass the information between workstations. Issues 

involving logical topologies are discussed on the Protocol chapter 

Tree Topology - LAN topology similar to linear bus topology, except that tree networks 

can contain branches with multiple nodes. 

WAN (Wide Area Network) - A network connecting computers within very large areas, 

such as states, countries, and the world. 

Workstation - A computer connected to a network at which users interact with software 

stored on the network. 

 

Business Information Systems: Information systems within a business organization that 

support one of the traditional functions of business such as marketing, finance, or 

production. Business information systems can be either operations or management 

information systems. 

Control: The systems component that evaluates feedback to determine whether the 

system is moving toward the achievement of its goal and then makes any necessary 

adjustments to the input and processing components of the system to ensure that proper 

output is produced. 

 Cross-Functional Information System: Information systems that cross the boundaries of 

functional business areas in order to support business processes across the organization. 

 Data: Facts or observations about physical phenomena or business transactions. More 

specifically, data are objective measurements of the attributes (characteristics) of entities, 

such as people, places, things, and events. 

Data or Information Processing: The act of converting data into information. 

Data Resources: Data, model, and knowledge bases 



 11

Decision Support Systems (DSS): An information system that utilizes decision models, a 

database, and a decision maker’s own insights in an ad hoc, interactive analytical 

modeling process to reach a specific decision by a specific decision maker. 

Enterprise Collaboration Systems: Enhance collaboration among networked teams and 

workgroups 

Executive Information Systems (EIS): Information systems that provides strategic 

information tailored to needs of top management. 

Expert System: A computer-based information system that uses its knowledge about a 

specific complex application area to act as an expert consultant to users. The system 

consists of a knowledge base and software modules that perform inferences on the 

knowledge, and communicates answers to a user’s questions. 

Feedback: Data or information concerning the components and operations of a systems 

performance. 

Hardware Resources: Includes all physical devices and materials used in information 

processing (machines and media). 

Information: Data that has been placed into a meaningful context for an end user. 

Information System Activities: Input, processing, output, storage, and control 

Information System Model: An information system uses people, hardware, software, 

network, and data resources to perform input, processing, output, storage, and control 

activities that transform data resources into information products. 

Integrated Information Systems 

Information systems that combine the capabilities of several types of information 

systems. 
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Knowledge Management System: Collect, organize, and disseminate business know-how 

within a company. 

Management Information System: Information systems designed to provide information 

needed for effective decision-making by managers. 

Management Support System: Include executive information systems, decision support 

systems, and management information systems. 

Network Resources: Network resources include communications media and network 

support. 

Operations Support Systems: Include office automation systems, transaction processing 

systems, and process control systems. 

People Resources: IS Specialists and end users. 

Process Control Systems: Computer-based systems that control an ongoing physical 

process such as petrochemical production. 

Programs: A set of instructions that cause a computer to perform a particular task. 

Procedures: Set of instructions used by people to complete a task. 

Strategic Information Systems: Information systems that provide a firm with competitive 

products and services that give it a strategic advantage over its competitors in the 

marketplace. 

Subsystem: A system that is a component of a larger system 

System: A system is a group of interrelated components working together toward a 

common goal by accepting inputs and producing outputs in an organized transformation 

process. 
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Transaction Processing Systems (TPS): Information systems that process data arising 

from the occurrence of business transactions. 

Types of Information Systems: Information systems can be classified into operations, 

management, and other categories 

 

1.5 Application  of Computer, Advantages and Disadvantages 

Computers have become important tools in our day-to-day’s operations. Some of the 

areas computers are used are in: 

 

 

Engineering 

In engineering computers are used for designing using computer aided design (CAD) 

software. Modelling and testing processes etc.  

 

In Biosystems engineering, computers are being used for biometric analysis, genetic   

engineering and cloning etc. 

 

Space exploration would hardly be impossible without the assistance of computers. 

 

Manufacturing 

Computers have made industrial processes more efficient through optimization 

scheduling, process control, and using robots to perform automated manufacturing 

process control which are otherwise dangerous to human beings. 
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Automobile assembly robot at work 

 

 

 

A wire repair robot at work 

 

 

 

Communication 
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The integration of computers and communication technologies is what is being referred 

to as ICT. This merger has resulted to more efficient communication using computers and 

other handheld devices such as mobile phones used to facilitate sending and receiving of 

messages over the internet. Computers also control many telecommunications equipment. 

 

 

 

 

Education and research 

� Computers are used in educational institution as teaching aid, online teaching 

especially in open and distance learning and to enhance management.  

� Internet contains a lot of information for researchers, scholars and 

teachers/lecturers. 

 

 

 

Everyone 
and Everything 

Participating on the 
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Computers in education 

 

 

Other application areas 

� Law enforcement to carry out biometric mapping activities like fingerprint 

matching and store forensic information. 

� Banking to keep client accounts details and issue cash transaction services at the 

automated teller machines (ATM). 

 

System Software 

Does fundamental tasks such as computer boot up and system control. System software 

are further classified into: 

1. Operating system 

2. Utility software 

3. Network software 

4. Firmware 

Fundamentals of Computing 
16 
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Operating System 

An operating system is a program that manages the computer hardware resources and 

controls the execution of application programs. Examples are:  

1. Microsoft Windows 98/2000/Me/2003/Vista 

2. UNIX 

3. Linux  

4. MacOS 

 

Utility Software 

Utility software also called service programs are special programs  used to enhance 

perform both at system and user levels. 

System level utilities optimizes system performance while application level utilities help 

in smooth running of application programs. Examples are  

1. Norton utility 

2. McAfee suites 

 

Network Software 

Networking software enables computers and other peripheral devices connected on a 

network to communicate and share resources. Examples are: 

1. Novell Netware 

2. UNIX 

3. Windows NT based operating systems 

 

Firmware 

Firmware,  also referred to as stored logic is an integration of both hardware and software 

on a single silicon chip. These are mostly packaged as ROM chips.  
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Advantages and disadvantages of computer  

In this lecture, you will be introduced to the advantages and disadvantages of computers.   

Advantages of computers 

� Large storage of data in small amount of space. 

� Quick and accurate calculations than humans. 

� Continuously work with repetitive work( contusive environment)  

� Simulation of dangerous situations. 

Disadvantages  

� Expensive to introduce. 

� Health hazards. 

� Downtime-. 

� Redundancy in the work place. 

� It can lead to misuse of information. 

 

1.6 DOS, Windows, File and Extension Programs 

Below is a comparison of DOS and Windows 

 

Comparison of DOS and Windows 

 

DOS WINDOWS 

Command line interface GUI 

Terminate and stay resident (TSR) 

memory – one at a time 

The memory is dynamic – can load 

many programs at the same time 

Does not allow multi-tasking – run only 

one program job at a time 

Allows multi-tasking – run many 

programs/jobs simultaneously 

Filename is limited to only 8.3 

characters 

Filename has upto 128 characters - 

128.3, 4 characters 

No spaces in filename Allows spaces in filename 

Commands keyed-in through the 

keyboard 

Commands keyed-in through the             

The mouse 

Not user friendly User friendly 
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File extensions and programs 

FILE EXTENSION PROGRAM 

.XLS Excel 

.DOC Winword, MS-Word 

.RTF Winword, MS-Word 

.BAT Batchfile 

.DAT Data files 

.INI Initialization files, text files 

.COM Command interpretor 

.TMP Temporary files 

.HTML Internet explorer 

  

 

 

1.7 Summary 

In this lecture, you have been exposed to definitions and basic parts of 

a computer. Computer concepts, their definitions, functions and 

applications have been explained and diagrams for identification of a 

computer and its parts presented. Advantages and disadvantages of a 

computer have been discussed and we have also made comparisons of 

the DOS and the Windows, file extensions and programs. 

 

 

Activity 1.1  

1. Practice drawing parts of a computer and try to identify them on 

the computer.  

 

2. Define the concepts in their own words and  practice with each 

other the terminologies and applications of the terms. 
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Activity 1.2  

 
1. Define the following terms indicating their functions: 

 FAT, Formatting, Bios, Multitasking, Byte, Processor, Path,              

Program, Memory, Megabyte, Hub, LAN, Expert style,. 

(b) Diagramatically show the interrelatedness of input,  

processes, output and discuss their functions. 

(c) Define and discuss the four basic parts of a computer. 

(d) Clearly explain the following types of software: 

       System software, Operating system, Utility software, 

Network software, Firmware, Application software, 

Database software, Presentation software 

(e) What are the advantages and disadvantages of a 

computer? 

(f) Clearly explain the differences between DOS and 

Windows: File and Extension Program 

 

 

 

Further Readings 

1. Bartee, T.,1984. Introduction to Computer Systems 

McGrall-Hill International Book company, Aukland 

 

2. Stallings, William 2009.Operating Systems: Internals 

and Design Principles (6thEd) Prentice Hall-Pearson 

 

 



 21

LECTURE TWO 

  TYPES OF COMPUTERS 

Lecture Outline 

2.1 Introduction 

2.2 Lecture Objectives 

2.3 Super computers 

2.4 Mini computers 

2.5 Micro computer 

2.6 Laptop 

2.7 Main frame computers 

2.8 Embedded computers 

2.9 Terminal computers 

2.10 Cloud computers 

2.11 Summary 

2.13 Questions for practice  

2.14 Suggestion for further reading 

 

2.1 Introduction 

In this lecture you will learn about the different types of computers and practice how to 

use of some of these computers.  We shall also see how the various computers look like 

and the functions they perform in various organizations.  Latest computers such as cloud 

computers will also be discussed. 

 

  

Objectives  

By the end of this lecture, you should be able to: 

1. Recognize super computers 

2. Use Mini computers 

3. Describe how Main frame computers are used by large 

organizations 

4. Recognize and use Cloud computing 

5. Identify and name any other type of computers  
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We are going to learn about the following types of computers.  Carry up your hand if you 

know any of these computers. 

Supercomputers 

Minicomputers 

Microcomputers 

Laptops/notebooks 

Mainframe computer 

Embedded computers 

     Terminals 

Cloud computing.  

This is how some of the computers look like 
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Microcomputers 

 

Desktop PC 
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Laptop/Notebook PC 

 Pocket PC 



 25

Minicomputers 
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A mainframe computer 
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A super computer 

 

 

 

2.3 Super Computers 

Supercomputers 

Unlike mainframes and minicomputers, supercomputers are used for the heavy stuff like 

weather maps, construction of atom bombs, finding oil, earthquake prediction, and 

sciences where a lot of calculations must be done.  

 

They are also used to help governments eavesdrop on anything passing through 

telephone, data lines, e-mail, or radio waves; and anything that is written, etc. 

Historically, a supercomputer is associated with the fastest computer available or the 

largest in size.  

 

Supercomputing means "mass computing at ultra high speed." 
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Though all contemporary personal computers perform in the tens or hundreds of 

megaflops (millions of calculations per second), they still cannot solve certain problems 

fast enough. 

 

Construction of supercomputers is an awesome and very expensive task.  

To get a machine from the laboratory to the market may take several years. 

Using a supercomputer is expensive as well.  

As a user, you are charged according to the time you use the system what is expressed in 

the number of processor (CPU) seconds your program runs. 

Why do we need a supercomputer? Well, as a normal person on the street, you don't. 

Your cell phone or PDA has more computing power than the first mainframes. 

 

Who really needs supercomputing today are mostly scientists performing mass 

computing at ultra high speed. They use such computers in all imaginable disciplines: 

space exploration and related imagery (picturing galaxies and intergalactic matter), 

environmental simulations (global warming effects) mathematics, physics (the search for 

the really smallest part of matter), gene technology (what gene it is that makes us old), 

and many others. 

 

As you can see in the table below, the ranking of a supercomputer is near the top of the 

computer spectrum. 

 

2.4 Minicomputers 

Introduced in the early 1960s and announced a new era in computing. They are relatively 

low cost and small. Historically, a mini is associated with de-centralized computing. 

Meaning most computing takes (physically) place on the mini itself   

 

2.5 Microcomputers  

A microcomputer
 is a computer with a microprocessor as its central processing unit. 

Another general characteristic of these computers is that they occupy physically small 

amounts of space when compared to mainframe and minicomputers.  
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Many microcomputers (when equipped with a keyboard and screen for input and output) 

are also personal computers 

Monitors, keyboards and other devices for input and output may be integrated or 

separate.  

Computer memory in the form of RAM, and at least one other less volatile, memory 

storage device are usually combined with the CPU on a system bus in a single unit. 

Other devices that make up a complete microcomputer system include, batteries, a power 

supply unit, a keyboard and various input/output devices used to convey information to 

and from a human operator (printers, monitors, human interface devices)  

Microcomputers are designed to serve only a single user at a time, although they can 

often be modified with software or hardware to concurrently serve more than one user.  

Microcomputers fit well on or under desks or tables, so that they are within easy access 

of the user.  

Bigger computers like minicomputers, mainframes, and supercomputers take up large 

cabinets or even a dedicated room. 

 

A microcomputer comes equipped with at least one type of data storage, usually RAM.  

Although some microcomputers (particularly early 8-bit home micros) perform tasks 

using RAM alone, some form of secondary storage is normally desirable. In the early 

days of home micros, this was often a data cassette deck (in many cases as an external 

unit). Later, secondary storage (particularly in the form of floppy disk and hard disk 

drives) were built in to the microcomputer case itself. 

 

Microcomputers, or PC's as they are often called, are abundant on our desks, tables, 

offices, suitcases, everywhere.  

This is the most visible form of computers in the present world and comes in all forms 

and breeds.  

There are many generations of particular design and technical specifications from the 

start of this particular design. 

Historically, a micro is associated with stand alone computing.  
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Meaning most computing takes (physically) place on the micro itself.  

In the 1980's when networking started to integrate into the offices PC'S became 

connected with network servers, and also mainframes and supers. 

 

2.6 Laptops/notebooks 

A laptop computer or simply laptop (also notebook computer, notebook and notepad) is 

a small mobile computer, typically weighing 1.4 to 5.4 kg, although older laptops may 

weigh more. 

 

Laptops usually run on a single main battery or from an external AC/DC adapter that 

charges the battery while also supplying power to the computer itself even in the event of 

a power failure.  

 

Laptops contain components that are similar to their desktop counterparts and perform 

the same functions, but are miniaturized and optimized for mobile use and efficient 

power consumption, although typically less powerful for the same price.  

 

Laptops usually have liquid crystal displays (flat display device made up of any number 

of color or monochrome pixels arrayed in front of a light source or reflector. It is often 

utilized in battery-powered electronic devices because it uses very small amounts of 

electric power.) and most of them use different memory modules for their random access 

memory (RAM), for instance, SO-DIMM in lieu of the larger DIMMs. utilize a touchpad 

or a pointing stick, though an extern can  

2.7 Mainframe Computer 

Mainframes are computers used mainly by large organizations for critical applications, 

typically bulk data processing such as census, industry and consumer statistics, ERP, and 

financial transaction processing.  

 

The term probably originated from the early mainframes, as they were housed in 

enormous, room-sized metal boxes or frames. 
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Characteristics 

Nearly all mainframes have the ability to run (or host) multiple operating systems and 

thereby operate not as a single computer but as a number of virtual machines.  

In this role, a single mainframe can replace dozens or even hundreds of smaller servers, 

reducing management and administrative costs while providing greatly improved 

scalability and reliability. 

Mainframes can add or hot swap system capacity non disruptively and granularly. 

 

2.8 Embedded Computers  

� Embedded computers can be compared to "computers on a chip".  

� All in one so to speak. You will find them in all kind of appareils that 

surround us.  

� Washing machines, ticket machines at the subway, camera's, cars, motors, 

sewing machines, clocks.  

� Everywhere needing something to regulate, control of check something. 

� Historically, embedded computing is associated with self contained pre-

programmed computing. 

� Meaning there are mostly no connections outside the environment where that 

particular type of computing takes (physically) place and influences the working 

of that embedded computing device. 

 

2.9 Terminals  

1. Terminals exist in all forms and breeds.  

2. There are "smart" and "dumb" terminals used for a enormous variety of 

purposes. 

3. Historically, a terminal is associated with de-centralized computing.  

4. Meaning most computing takes (physically) place somewhere else then where 

the terminal is physically situated 
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2.10 Cloud Computers (computing).  

Usually based up in the satellite and stores information instead of the  common current 

ways of storages. 

 

 

2.11 Summary  

In this lecture, different types of computers have been identified and 

you have been able to describe the mainframe computers, 

minicomputers, supercomputers and cloud computers.  The following 

are the major points covered on different types of computers: 

Super computer 

� Fastest computer in the world. 

� Very large and may take several rooms. 

� Used in fields that require vast amounts of complex 

mathematical calculations eg simulating and nuclear research. 

Main frame 

� Very fast large-scale computer systems. 

� Have a large number of terminals and peripheral devices 

because they are used simultaneously by hundreds ( or even 

thousands ) of persons. 

� Larger than super computers. 

� A large memory and large storage capacity. 

Uses  

� In banks for processing customer accounts. 

� By utility companies for processing telephone, water and 

electricity bills. 

� By airlines for making flight arrangements. 

� By Universities for processing exams and payrolls 

Minicomputers  

� They support fewer users than mainframes. 

� Smaller than the main frame. 

Examples of application  
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� In networking the operations in an automobile sales and 

service outlet. 

� In manufacturing, for inventory control, accounts and process 

control. 

Microcomputer. 

� Used in homes for recreation. 

� For communication through the use of internet services. 

� In an office for processing documents and processing data eg 

payroll, inventory etc. 

 

 

Activity  2.1  

Students discuss in groups and identify the different types of 

computers and learn how to work on computers. 

 

 

 

Activity  2.2  

(a) Discuss the following types of computers and give examples of 

each: 

Super computers, minicomputers, microcomputers, laptop, 

mainframe, embedded,  terminal, and cloud computers 

(b) What are the functions of each of  the computers named in (a) 

(c) Indicate the organization where each of the computers is 

appropriately used. 

(d)  Explain how a notebook PC differs from a pocket PC 
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2.12 Further Reading 

1. Tiebel, Walter A., and Artar Singh 1991. The 68000 and 68020 

Microprocessors, Architecture, Software and Techniques. 

Printice-Hall International Inc.  Englewwod Cliffs 

 

2. Luehrmann, Arthur  and Herbert Peckham 1983. Computer 

Literacy: A hands-on Approach (1St Ed). McGraw-Hill 

Book Company 
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LECTURE THREE 

 COMPUTER SYSTEMS 

Lecture Outline 

3.1 Introduction 

3.2 Objectives 

3.3 Hardware 

3.4 Software 

3.5 Summary 

3.6 Questions for Practice 

3.7 Further Readings 

 

3.1 Introduction   

The section will expose students to computer hardware parts, their definitions and use. 

Typical pc hardware, mother-board, removable media devices such as CD, DVD will be 

explained.  Students will also learn how to use floppy disks, USB Flash, internal storage, 

sound card and networking. 

 

3.2 Objectives 

By the end of the lecture, you will be able to: 

1. Identify and name the computer hardware 

2. Describe the various functions of computer hardware 

3. Discuss the categories of  software  

4. Use computer software 

 

3.3 Computer Hardware 

These are physical parts such as the system unit and peripheral devices.  Peripheral 

devices connect to the system unit. They include: 

� Input devices,  

� Central processing unit (CPU),  

� Output devices  

� Storage devices  
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Computer Hardware is different from computer software as illustrated below: 

 

Hardware  Software  

Physical components of the computer Programs that run on the hardware. 

 

Hardware is the physical parts of the computer like the monitor, keyboard, mouse, 

speakers, and of course the computer itself called the system unit.  Hardware is also the 

parts inside the system unit that you can’t see unless  

you open  

 

Computer hardware is the physical part of a computer, including its digital circuitry, as 

distinguished from the computer software that executes within the hardware. The 

hardware of a computer is infrequently changed. 

 

Typical PC hardware 

A typical personal computer consists of a case or chassis in a tower shape (desktop) and 

the following parts: 

Motherboard - It is the "body" or mainframe of the computer, through which all other 

components interface. 

Central processing unit (CPU) - Performs most of the calculations which enable a 

computer to function, sometimes referred to as the "brain" of the computer.  

Computer fan - Used to lower the temperature of the computer; a fan is almost always 

attached to the CPU, and the computer case will generally have several fans to maintain a 

constant airflow.  

Random Access Memory (RAM)' - Fast-access memory that is cleared when the computer 

is powered-down. RAM attaches directly to the motherboard, and is used to store 

programs that are currently running.  
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Power supply - A case control, and (usually) a cooling fan, and supplies power to run the 

rest of the computer 

Storage controllers - Controllers for hard disk, CD-ROM and other drives 

Video display controller - Produces the output for the visual display unit. This will either 

be built into the motherboard or attached in its own separate slot  

Removable media devices:- 

CD-ROM Drive - a device used for reading data from a CD.  

CD Writer - a device used for both reading and writing data to and from a CD.  

DVD (digital versatile disc) - a popular type of removable media that is the same 

dimensions as a CD but stores up to 6 times as much information. It is the most common 

way of transferring digital video.  

DVD-ROM Drive - a device used for reading data from a DVD.  

DVD Writer - a device used for both reading and writing data to and from a DVD. DVD-

RAM Drive - a device used for rapid writing and reading of data from a special type of 

DVD.  

Floppy disk - an outdated storage device consisting of a thin disk of a flexible magnetic 

storage medium.  

Zip drive - an outdated medium-capacity removable disk storage system, first introduced 

by Iomega in 1994.  

USB flash drive - a flash memory data storage device integrated with a USB interface, 

typically small, lightweight, removable, and rewritable.  

Tape drive - a device that reads and writes data on a magnetic tape, usually used for long 

term storage.  
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Internal storage 

Hardware that keeps data inside the computer for later use and remains persistent even 

when the computer has no power. 

Hard disk - for medium-term storage of data.  

Sound card Networking 

Connects the computer to the Internet and/or other computers. 

Modem - for dial-up connections  

Network card - for DSL/Cable internet, and/or connecting to other computers Direct 

Cable Connection - Use of a null modem, connecting two computers together using their 

serial ports or a Laplink Cable, connecting two computers together with their parallel 

ports. 

  

Other peripherals 

In addition, hardware devices can include external components of a computer system. 

The following are either standard or very common. 

Includes various input and output devices, usually external to the computer system 

Input Text input devices  

Keyboard - a device, to input text and characters by depressing buttons (referred to as 

keys), similar to a typewriter. The most common English-language key layout is the 

QWERTY layout.  

Pointing devices  

Mouse - a pointing device that detects two dimensional motion relative to its supporting 

surface.  

Trackball - a pointing device consisting of an exposed portruding ball housed in a socket 

that detects rotation about two axes.  
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Xbox 360 Controller - A controller used for Xbox 360, Which with the use of the 

application Switchblade(tm), can be used as an additional pointing device with the left or 

right thumbstick.  

Gaming devices  

Joystick - a general control device that consists of a handheld stick that pivots around one 

end, to detect angles in two or three dimensions.  

Gamepad - a general game controller held in the hand that relies on the digits (especially 

thumbs) to provide input.  

Game controller - a specific type of controller specialized for certain gaming purposes.  

Image, Video input devices  

Image scanner - a device that provides input by analyzing images, printed text, 

handwriting, or an object.  

Webcam - a low resolution video camera used to provide visual input that can be easily 

transferred over the internet.  

Audio input devices  

Microphone - an acoustic sensor that provides input by converting sound into an 

electrical signals  

it up.  Parts like the motherboard, expansion cards, and modem.  Many hardware devices 

can be attached to a system unit to expand its capabilities, such as a speaker, scanner or 

printer 

Hardware Elements 

Storage devices 
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Secondary storage devices (auxiliary storage) are so called  because unlike primary 

storage, they are not directly accessible by the CPU.   

Secondary storage offer long term storage for data and information. They can be 

classified according to: 

� Portability (removable or fixed) 

� Technology used to store (magnetic, optical or solid state).  

Magnetic tapes 

 

 

A magnetic tape is made using a thin ribbon of mylar (plastic) coated with a 
thin layer of magnetic material composed of iron oxide. 
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Floppy disks 

 

 

 

Zip Disk 

The Zip disk is a special type of diskette, which can hold data of up to 750 MB. It is   

stable, inexpensive and easy to work with. Zip disks are read using a zip drive which may 

be internal or external. 

Optical storage media are so called because data is written and read from them using a 

laser beam. 

Compact disks  

A floppy disk has concentric circles called tracks in which data is written. The 
tracks are further divided into units called sectors 
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A compact disk (CD) is made of a small plastic disk with a reflective aluminum coating 

on one side. CDs can store data of approximately 700MB. There are three common types 

of CDs namely read only, recordable and rewritable CDs.  

Digital versatile disk (DVD)  

Digital versatile disks resemble CD-ROMs in every aspect only that they can store more 

data than CD-ROMs.   

 

For example, a typical DVD can store approximately 17 GB. Just like CDs, there are 

three common types of DVDs namely read only, recordable and rewritable DVDs. 

 

Solid state storage devices 

 

Solid state storage is a kind of nonvolatile storage media that employs 
integrated circuits rather than mechanical, magnetic or optical technology. 
Examples of solid state devices include flash disks and memory cards 
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Hard Disks 

A hard disks also known as hard drive is an example of fixed storage. However, this is 

not absolutely the case because some hard disks are removable.  

 

It is called a hard disk because it is made up of metallic disk platters housed in a 

protective metal case. The read/write head moves just above the surface of the rapidly 

rotating disk to read or write data.  

 

 

One of the advantages of the hard disk over the other storage media is that they store very 

large volumes of data and offer faster data access.  

To avoid accidental loss of data or information observe the following: 
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Care of Storage Media 

1. Do not expose a magnetic media to strong magnetic fields.   

2. Do not expose a media to excessive heat.  

3. Do not drop, bend or scratch the media 

4. Do not remove a media from the drive when it is still being accessible by the 

computer 

 

Computer Software  

Software - software is the instructions given to the computer that tells it what to do.  A 

computer cannot do anything without instructions. A computer must first read 

instructions before it can start to work. These instructions are called operating system 

software. When a computer is turned on, the first thing it does is find and read its system 

software. This software tells the computer how to work; how to be a computer. Once a 

computer has done this and is “booted up” or ready to go, it can read other instructions 

called application software. This type of software tells the computer how to do a specific 

task with a user, like writing a report, playing a game, or creating a graph. 

 

Software also referred to as programs is a set of instructions that directs a computer what 

to do. Generally classified into: 

1. System software 

2. Application software 

 

System Software 

Does fundamental tasks such as computer boot up and system control. System software 

are further classified into: 

1. Operating system 

2. Utility software 

3. Network software 

4. Firmware 
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Operating System 

An operating system is a program that manages the computer hardware resources and 

controls the execution of application programs. Examples are:  

Microsoft Windows 98/2000/Me/2003/Vista 

UNIX 

Linux  

MacOS 

 

Utility Software: 

Utility software also called service programs are special programs  used to enhance 

perform both at system and user levels. 

System level utilities optimizes system performance while application level utilities help 

in smooth running of application programs. Examples are  

Norton utility 

McAfee suites 

 

Network Software: 

Networking software enables computers and other peripheral devices connected on a 

network to communicate and share resources. Examples are: 

Novell Netware 

UNIX 

Windows NT based operating systems 

 

Firmware: 

Firmware,  also referred to as stored logic is an integration of both hardware and software 

on a single silicon chip. These are mostly packaged as ROM chips.  
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3.5 Summary 

In this lecture you have learnt computer hardware and software. Specific 

functions of computer hardware and software have been discussed and 

you have been able to use the various categories of computer software. 

 

Activity  3.1  

Students open computers for identification of hardware and naming. 

Students practice use of various software on desktops. 

 

 

 

 

Activity  3.2  

How are systems software classified? 

2. Discuss and give examples of operating systems. 

3. How does utility software differ from network software? 

4. Differentiate hardware from software system.(ii) what are their 

functions 

 

 

3.8  Further Reading 

1. Timothy J.O’Leary and Linda I.O”Leary 2010. Computing 

Essentials, Introductory  The McGraw-Hill Companies, Inc. 

 

2. Stallings, William 2009.  Operating Systems: Internals and 

Design Principles (6th Ed)  Prentice-Hall-Pearson 
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LECTURE FOUR 

 CATEGORIES OF COMPUTER SYSTEMS 

Lecture Outline 

4.1 Introduction 

4.2 Objectives 

4.3 CPU 

4.4 Input devices 

4.5 Processing-converting inputs into outputs 

4.6 Output devices 

4.7 Summary 

4.8 Questions for practice 

4.9 Further Reading 

 

4.1 Introduction 

The lecture exposes students to categories of computer systems.  The CPU as the brain of 

the computer that contains registers for holding data instructions, peripheral devices such 

as the input and output and the processing which involves converting input into output 

are identified and discussed. 

 

4.2 Objectives 

By the end of the lecture, you will be able to: 

1. Describe the CPU  and its functions 

2 Discuss and identify the functions of input devices 

3. State the process of converting input into output 

4. Produce printed material from a computer 

 

4.3 Central  Processing Unit (CPU) 

We are going to learn about the brain of a computer called the CPU.  It is the brain of the 

computer because it  is where data is manipulated and arithmetic and logic carried out. 

� The central processing unit (CPU) also referred to as the processor is the central 

part of the computer where data processing takes part. It is regarded as the brain 
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of the computer.  Take out the intestine, and you are dead.  In the same way, take 

out the CPU, the computer would be dead.  

� As mentioned earlier, the CPU of a microcomputer is a tiny chip etched into a 

silicon chip. The processor is mounted onto a board known as the motherboard or 

system board. 

�  

The Central Processing Unit (CPU) is the brain of the computer.  It is a computer chip 

found on the motherboard that carries out instructions, directs the flow of information 

through the system, and makes calculations. It works very quickly carrying out millions 

of instructions each second. It is a very complex computer chip.  Manufacturers are 

continually improving CPUs to be more powerful and faster.  Just as there are different 

makes of cars and other products, there are different manufactures of computer chips 

such as Intel, MD and Cyrix.   are improved, each generation is more powerful than 

those. 

 

The CPU and the Memory are the two components in a computer that handle data 

processing.  

The CPU is where data is manipulated. 

It is considered the brain of the computer. 

In a PC, the entire CPU is contained on a tiny chip called the micro-processor. 

Every CPU has at least 2 basic part – the Control Unit and the Arithmetic and 

Logic Unit (ALU). 

 

Control Unit 

The CPU’s function is to coordinate al the activities of the computer. 

All the computer resources are managed from the CPU. 

The CPU can be considered as a traffic policeman directing the flow of data around the 

CPU and around the computer. 

The CU contains the CPU’s instructions for command execution. 

The instruction set, which is built into the circuitry of the CPU is a list of all possible 

operations that the CPU can perform. 
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Each instruction in the instruction set is accompanied by a micro-code which are very 

basic instructions that tell the tell CPU how to execute the instruction. 

The control circuitry is the primary functional unit within the CPU using clock inputs. 

The CU maintains the proper sequence of events required for any processing 

 

Arithmetic and Logic Unit (ALU). 

When the CU encounters an instruction that involves arithmetic or logic, it passes control 

to the 2nd components of the CPU – the ALU. 

ALU includes a group of registers which are memory locations built directly into the 

CPU that are used to hold data that are being processed by the current instruction. 

 

The ALU must contain an adder capable of combining the contents of two registers in 

accordance with the logic of binary arithmetic. 

+, - , *, / < , > 

Arithmetic Logic 

 

Memory 

The CPU contains the Logic and Circuitry to run the computer but does not have room to 

store programs and data. 

The CPU contains registers for holding data and instructions. 

The CPU also requires space where it can holed whole programs and data being 

manipulated by these programs. 

There are two types of memory – RAM and ROM 

 

ROM 

Means that computer can read contents of this memory but cannot write to that area of 

memory. 

The contents of ROM cannot be altered. 

ROM performs a check the functionality of a PC when it is first powered on. 

ROM contains boot (start-up) instructions that ensure that the rest of memory is 

functioning properly. 
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ROM is non-volatile 

Functions: 

Checks if the rest of the memory is functioning 

Checks for al hardware devices available 

Check the operating system in harddisc 

Passes control to the OS. 

 

RAM 

Memory that can be changed or altered 

The computer holds data for the current processing task 

RAM serves as a place to store instructions which direct the activities of the CPU and 

data processed by the CPU. 

RAM is volatile. 
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Motherboard 

 

 

4.4 Input 

Input devices 

Have you heard of a typewriter? How many have seen a typewriter and how it works? 

How a bout a mouse not a rat? Anybody who has ever been taken a picture by a camera? 

Have you ever scanned a document, a letter? 

 

Input devices are used to enter data into a computer. Data entered is first converted into 

machine code (binary digitsform – 1s and 0s) in short bits before processing takes place. 

For example 00000101 may be used to represent 5. Input devices are used to enter data 

into a computer. Data entered is first converted into machine code (binary digitsform – 1s 

and 0s) in short bits before processing takes place. For example 00000101 may be used to 

represent 5. 
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Input devices can be classified according into: 

 

� Keying devices 

� Pointing devices  

� Scanners 

� other technologies. 

 

Keying Devices 

Keying devices such as keyboards and keypads are used for typing data and instructions. 

This is the most common way of entering data into the computer.  

 

 

 

 

Pointing devices 

Pointing devices are used to control a pointer or cursor on the screen.  They are mostly 

used on computers running graphical user interface (GUI) operating systems such as 

Microsoft Windows.  

 

Some examples of pointing devices include mouse, track ball, joystick, light pen and 

stylus. 
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Pointing devices 

 

 

Scanners 

Scanners are used to automatically capture data from the source and convert it into digital 

form.The two types of scanners are optical and magnetic scanners. Scanners are used to 

automatically capture data from the source and convert it into digital form. The two types 

of scanners are optical and magnetic scanners. 
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Mouse Joystick 
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Optical and magnetic scanners 

 

Digital Cameras 

� Digital cameras capture data the same way as other cameras but it is stored in 

digital form.  

� In digital cameras, pictures are stored on a memory card instead of film. 
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Optical scanner ATM – Magnetic card reader 
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Digital cameras 

 

 

Voice Input 

Data can be entered directly into a computer using voice input devices such as 

microphones. A microphone is attached to a sound card which has an analog-digital 

converter. 

 

Emerging trends in voice input is the inclusion of voice tag in cell phones that allows the 

user to simply store and dial contacts.  

 

 

 

Touch Screen 

Touch screen works by allowing the user to touch the screen in order to select an item. 

The screen consists of infrared light crisscrossing behind it. When the user touches a 
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Digital video  camera 

Digital camera 
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location on the screen, the finger interrupts the infrared light and the command touched is 

executed.  

 

 

 

Digitizer 

A digitizer also known as graphic tablet is made up of a flat surface and allows the user to 

draw an image using a stylus. The image drawn does not appear on the tablet but on the 

computer screen.  The digitizer is used for tracing highly detailed engineering and 

architectural drawings and designs. 

 

4.5 Processing 

Information processing (or data processing) activities that occur in information system 

include the following: 

Input of data resources 

Processing of data into information 

Output of information products 

Storage of data resources 
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Control of system performance 

  

Input of Data Resources 

Data about business transactions and other events must be captured and prepared for 

processing by the input activity. Input typically takes the form of data entry activities 

such as recording and editing.  

Once entered, data may be transferred onto a machine-readable medium such as magnetic 

disk or type, until needed for processing.  

 

Processing of Data into Information 

Data is typically subjected to processing activities such as calculating, comparing, 

sorting, classifying, and summarizing. These activities organize, analyse, and manipulate 

data, thus converting them into information for end users.  

Output of Information Products 

Information in various forms is transmitted to end-users and made available to them in 

the output activity. The goal of information systems is the production of appropriate 

information products for end users.  

  

It is useful to think of information as having the three dimensions of: 

Time  Content  Form 

 

4.6 Output 

Output devices 

Output devices make it possible for the user to get processed information from the 

computer.  Examples of output include monitors, speakers, data projector, printers and 

plotters. 
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Sound output devices 

 

 

Sound output devices produce sound such as beeps, audio or digital sounds.  

Examples are speakers and headphones.   Some computers come with inbuilt 

speakers hence no need to connect external ones. An external speaker should be 

connected to a sound the jacks on the system unit or on a multimedia monitor. 

Fundamentals of Computing 
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Data projector 

 

 

 

A data projectors is used to display output from a computer on plain white screen 

like a wall or whiteboard. It is a creative way of presenting computer output to an 

audience and this technology is gradually replacing the traditional overhead 

projectors. 
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Printers 

 

 

Printers are used to produce hardcopies. A hardcopy can be defined as tangible 

output that can be seen and touched such as a print out. 

Fundamentals of Computing 60 
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Plotter 

 

 

 

 

4.7 Summary 

In summary, we have learnt the elements of CPU and noted 

the following: 

Regardless of size, a processor is consists of three 

functional elements namely  

� Control unit 

� Arithmetic & logic unit  

� Main memory (primary storage) 

Arithmetic and Logic Unit 

The arithmetic and logic unit (ALU)  performs arithmetic 

and logical operations on data as directed by the control 

A plotter print their output by moving a pen across the surface of a piece of paper. 

They are mostly used to line art such as engineering and architectural designs, 

maps and photos. 

Fundamentals of Computing 
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unit. Data to be executed by the ALU is temporarily held in 

special purpose memories located inside the processor 

called registers. 

Main Memory 

The main memory or primary storage store data and 

instructions that are directly accessible to the processor. The 

two main types of primary storage are Rndom access 

memory (RAM) and read only memory (ROM).  

 

RAM 

RAM mostly referred to as working storage is a volatile, 

temporary storage that holds input entered into the computer 

for processing and output after processing 

 

ROM 

ROM contains nonvolatile, relatively permanent data and 

instructions that cannot be easily changed.  Participants 

have therefore ,been exposed to categories of computer 

systems and learnt the functions of the CPU and how to use 

peripheral devices of the computer.  They have also been 

able to use computer input devices and learnt how data is 

processed to convert input into output. 

 

 

4.8 Activity  

 

Activity 

Participant learn how to use computer by inputting data and printing 

output 

They practice in groups using computers 
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4.9 Questions for practice 

1. Discuss the elements of a CPU and give their functions 

2. What are the classification of  Input Device? 

3. CPU is the intestine of the Computer. Discuss. 

4. What is a microprocessor? 

5. How does the arithmetic and logic unit function? 

6. Differentiate ROM from RAM  

7. What characteristics would make information valuable and useful to you? 

Answer: 

Examine the characteristics or attributes of information quality. 

Information that is outdated, inaccurate, or hard to understand would not be very 

meaningful, useful, or valuable to you or other end users. People want information 

of high quality, that is, information products whose characteristics, attributes, or 

qualities help make it valuable to them.  

 

 

4.10 Further Readings 

1. Timothy J.O’Leary and Linda I.O”Leary 2010. Computing Essentials, 

Introductory The McGraw-Hill Companies, Inc. 

 

2. French, C.S., 2009.  Data Processing and Information Technology 

(10th Ed)  CENGAGE learningMartins The Printers Ltd, UK. 
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LECTURE FIVE 

 STORAGE DEVICES AND MEDIA 

Lecture outline 

5.1 Introduction 

5.2 Objectives 

5.3 Primary Storage (RAM & ROM) and Media 

5.4 Secondary Storage (Magnetic Tapes, Floppy Disks, Hard Disks) And Media 

5.5 Summary 

5.6 Questions for practice 

5.7 Further Reading 

 

5.1 Introduction 

Participants will be taken through primary and secondary storage devices .  They will 

revise the concepts ROM and RAM and learn them as primary storage devices. 

Additionally, they will learn secondary storage devices and media. 

 

5.2  Lecture Objectives 

By the end of the lecture students will be able to: 

1. Differentiate computer primary storages, RAM and ROM 

2. Discuss the functions of the RAM as microcomputer volatile memory and the 

ROM as the microcomputer non-volatile memory  

3. Identify types of ROM and their disadvantages 

4. Discuss secondary storage devices and media 

5. Examines functions of various disks, floppy, hard, optical, CDs 

 

5.3 Primary Storage (RAM & ROM)  

  -There are two types:- 

 RAM- Random Access Memory. 

 Rom- Read Only Memory. 

  Comparison of the primary storages(main memory/ immediate access storage): 

- There are two types: RAM; ROM. 
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1. Random access memory (RAM) 

The contents in the memory are temporary and are lost whether computer is turned off 

(the data is volatile). 

Used to store the instructions and data for currently running programs and the 

operating system. 

2. Read only memory( ROM) 

Used to store data that must not be lost even when the computer is turned off eg the 

commands which start up (boot up) the computer. 

These instructions are programmed into the ROM chips by the manufacturers. 

The contents can only be read. 

They are usually programmed by the manufacturers. 

Used to store the commands and data that are executed each time the computer is 

turned on. 

 

Types of ROM  

Programmable Read Only Memory (PROM). 

Can be programmed with a special machine as opposed to using the expensive masks 

needed to produce large volumes of roll chips. Once a PROM is programmed, its 

contents cannot be changed. 

 

Erasable Programmable Read Only Memory. 

This type of ROM is designed so that its contents can be erased using ultra-violet light. 

Then the chip can be re-programmed. 

 

Disadvantages 

Its contents do not last as long as those of other types of ROM. because sunlight 

contains ultra-violet rays, you must protect EPROM chips from exposure to sunlight. 

 

A bit- a unit of storage that has two possible values, 0 and 1. it is the smallest unit. 

A byte- a group of eight bits (2 nibbles). 

A nibble- a group of 4 bits. 
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Word- the size of the data (or instructor) that the CPU can handle in  

a single cycle. 

Word-length/word size- the number of bits in a word. 

Address- the identification of a particular location in the memory where the data item or 

an instruction is stored. 

Address content- the data or instruction that is stored in a given address. 

Character- any digit, letter or symbol. 

Bistable devices-a device that can exist in one  of two possible states age on loftswitsh a 

bit; a key on a keyboard-it can either be up or down. 

 

5.4 Secondary Storage Devices and Media 

1. Magnetic tape 

� Used for storing large amounts of data. 

� Magnetic tape comes in the form of a reel or cartridge and is made in plastic  

 that is coated with a metal oxide. 

� The tape is divided into [parallel rows known as tracks. 

� The most common tape is one with nine tracks. 

� Tracks are one to eight and each store a bitin or byte. 

� Track nine is called parity track-used as a method of checking the accuracy of  

 data. 

� Each group of nine bits( one on each track) is known as a frame. 

� There are two types of parity:- odd parity( number of ones is odd) and even  

  parity( number of ones is even) 

� Magnetic tape is high-density, high speed and has a large capacity. 

� It is read using a magnetic tape drive. 

� Magnetic tape is used for:- backing up the data of the hard disk; data entry  

 using key-to-tape device; archiving data 
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2. Floppy disks 

� Typically used to store documents so that they can be used on more than one 

computer. 

� The term floppy disk is used to refer to a 5.25 inch flexible disk. Nowadays the term 

commonly used to refer what was known as microfloppy disk is the 3.5 inch disk. 

� Floppy disks are read by the floppy disk drives. 

 

Examples of the use and application of floppy disks are : 

1. Storing small programs. 

2. Backing up data files. 

3. Storing small documents. 

 

Precautions needed with floppy disks 

1.  Don’t place the disk on a device that has or generates a magnetic field eg a speaker. 

2. Don’t bend the disk. 

3. Don’t place the disk in hot or wet places. 

4.  Only write on the disk with a soft-tip pen. 

5. Don’t remove the disk from the drive when the disk’s drive light is on. 

 

Determining the storage capacity of a diskette 

� In order to determine the storage on any disk the following formulae: 

Storage capacity= number of surfaces x number of tracks x number of sectors per tack x 

number of bytes per sector. 

So for a floppy disk: 

The number of bytes per track= number of sectors per track x number of bytes per sector. 

 

= 18 x 0.5 KB= 91 KB. 

The number of bytes per side= number of bytes per tack x number of tracks per side. 

= 9KB X 80= 720 KB. 

 

The number of bytes on the disk= number of bytes per side x number of sides. 
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= 720 KB x 2= 720 KB or 1.44MB. 

 

Hard disk (fixed) 

� A hard disk is a large capacity, rigid magnetic disk that is sued for storing data. 

� Data is read from or written to a hard disk using an arm-like device known as 

read/write head. 

� Data may be read from/written to a hard disk using either a moving read/write 

head or a fixed head. 

� A moving read/write head moves to the track that corresponds to the data while 

the disk is spinning. 

� A fixed read/write head does not move. Instead there is a fixed head for each 

track. 

� This gives the fixed head system the advantage of having a faster access time ( 

time it takes for the data to be accessed) 

� This faster access time is because of the faster seek time( the time it takes the 

read/write head to get to s specific position on the disk) 

� The fixed head system is more expensive than the moving head system. 

� Hard drive- a collection of hard disks and read/write heads. 

Hard drive Floppy disk drive 

Much faster than a floppy disk drive Slower than the hard drive 

Each surface has a much larger capacity than 

a floppy disk 

Each surface has a lower capacity than a 

floppy disk 

Much more expensive Cheaper than the hard drive. 

Uses 

Used for storing a wide variety of things such as:- 

� Operating systems. 

� Office programs. 

� Multimedia programs. 

� Games. 

� Images, songs. 

� Databases. 
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Precautions needed with the hard disk 

� Don’t turn the power off without shutting the computer down through the normal 

shut-down procedure. Failure to shut down the computer correctly can lead to 

corruption of data. 

� Don’t subject the computer to severe vibrations or jerks or move the computer if 

the power is turned on. This could cause physical damage to the hard drive. 

 

Hard disk (Exchangeable)  

� It is similar to its fixed counterpart except that it can be removed from the hard 

drive (removing a fixed hard disk from a hard drive can damage it). 

� It is not as reliable as the fixed disk. 

 

Optical disk 

� These are disks that are read using laser beams eg CD’s and DVD’s. 

� They are both disc shaped objects with a hole in the middle and a reflective 

surface. 

� They store data in tracks. 

� An optical disk has only one track spiraling from the inside of the disk (the hole in 

the middle) to the outside of the disk. 

 

CD’s/compact discs  

� Can hold data worth 650-700 Mb. 

� There are three types of CD’s commonly used:- 

1. CD-ROM 

� The manufacturers distribute the programs on CD-ROM as opposed to other types 

of CD because it is the only type of CD found in the computer industry that is 

really suited for mass production. 

� Large number of CD-ROMs can be created in a manner similar to printing a book. 

� The original CD-ROM is created by using a laser to burn it. From this master, 

thousands of identical copies are created using CD-Rom makers. 
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� The reflective surface of the CD-Rom has combinations of pits (bumps) and lands 

(the flat areas with no bumps) that are used to represent data. 

 

Uses 

� Used to store songs. 

� Used to store files that can be recognized by the computer. These files are 

commonly used to store things like large programs, multimedia encyclopedias etc. 

-CD-ROMs can be read by CD-ROM drives and can also be read in CD-R and CD-RW. 

 

CD-R (Compact Disc Recordable) 

� It is a WORM (write only read many) storage media. 

� It means that a user can record on a blank CD-R but once he/she has finished 

recording, the CD-r can only be read. 

Uses   

Used for storing a wide variety of things such as:- 

� Operating systems. 

� Office programs. 

� Multimedia programs. 

� Games. 

� Images, songs. 

� Databases. 

 

Precautions needed with the hard disk 

� Don’t turn the power off without shutting the computer down through the normal 

shut-down procedure. Failure to shut down the computer correctly can lead to 

corruption of data. 

� Don’t subject the computer to severe vibrations or jerks or move the computer if 

the power is turned on. This could cause physical damage to the hard drive. 
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5.5       Summary 

The lecture covered computer storage devices focusing on primary 

and secondary storages.  Functions and uses of RAM, ROM, 

magnetic, optical and magnetic optical have been explained in 

detail. The summaries of the storage devices are given below. 

Primary storage devices 

� RAM. 

� ROM. 

RAM ROM 

Can be read and written to Can only be read. 

Volatile memory Permanent. contents not lost when the computer i

Running programmes Hold information for booting and starting.

Faster than ROM Slower than RAM 

 

Similarities  

� Both use chips 

� Information can be accessed randomly from both. 

 

Secondary storage devices 

� HD 

� Magnetic tape. 

� Floppy disks. 

� Microfilm. 

� CD’s 

� DVD’s 

Secondary storage are generally grouped as follows: 

1. Magnetic. 

2. Optical 

3. Magnetic optical. 

Used for backup  

Computer Bus. 
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Computer card. 

 

Digital devices- discrete data(takes a finite number of options) 

Analog devices- continuous data eg height. 

 

 

 

                     Continuous data  

 

 

 

 

 

 

 

 

                                 Discrete data 

 

 

 

 

 

 

 

 

 

Activity 5.1  

Students practice on computers. 

Identify and draw the following showing their functions: 

hard disks, floppy disks, magnetic tapes, microfilm CDs, DVDs etc 

Describe the following storage devices-magnetic tape drive, hard 

drive, floppy drive 
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Activity 5.2  

 Describe the following storages: hard disks, floppy disks, 

magnetic tapes, microfilm CDs, DVDs etc 

2. Describe the type of data  stored in secondary storage 

(magnetic tapes, floppy disks, hard disks) 

3. Compare and contrast the RAM and ROM 

 
 

 

5.8 Further Readings 

1. Govindaraju S., M,Chandrasekaran,A.Abdul Haq, and 

T,R.Narayanan 1996.   Introduction to Computer Science New 

Age International (P) Ltd. Publishers 

 

2. Timothy J.O’Leary and Linda I.O”Leary 2010.Computing 

Essentials, Introductory  The McGrawHill Companies Inc. 

 

1 
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LECTURE SIX:  PROGRAMMING METHOD FOR PROGRAMS 

Course outline 

6.1 Introduction 

6.2 Lecture Objectives 

6.3 Programming Method to create Programs 

6.4 Numeric & Strings 

6.5 Summary 

6.6 Activity 

6.7 Suggestion for further reading 

 

6.1 Introduction 

The lecture provides an explanation of computer programming as a method used to 

create computer programs.  Computer language is explained as means to communicate 

with a computer.  Algorithm is another language used to solve problems and so are 

mathematical expressions. 

 

 

6.2 Lecture Objectives 

By the end of the lecture, the student should be able to: 

1. Analyze a programming language based on generic 

characteristics. 

2. Discuss virtual machine translation, compiling code 

generation and interpreters 

3. Differentiate numeric from string 

4. Discuss numeric variables and string variables 

 

6.3 Computer programming 

Method used to create computer programmes. 

- Computer language means to communicate with the computer. 

- Algorithm- step by step procedure to solve a problem. 

Review of typical elements of (imperative) programming languages  

Compiler and interpreters 
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Specification of syntax and semantics of programming languages: 

- Expressions and assignments 

- Side effects 

- Control structures  

- Data and procedural abstractions 

- Parameter passing mechanisms 

- Binding  

- Scopes 

- Type system 

Recursive descent technique used for illustration of aspects of syntax analysis 

Code generation  and error recovery 

Language interpreters for low-level and high level languages. 

 

6.4 Numeric Vs String 

� Numeric- just a number:- integer (no decimals); floating point( number with 

decimals) 

� String- collection of characters. Differentiating between string and numeric string-

enclosed in double quotes. 

 

Mathematical expressions  

� + 

� - 

� * 

� / 

� ^- exponent eg for square root. 

 

-Variable: name given to a storage location in the computer memory. 

-There are two main types of variables:- 

1. Numeric variables. 

2. String variables. 
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Assign statement  

� Giving a fixed value to a variable  eg duty=0.16 

- String variables look the same as numeric variables except the $ sign at the 

end of the name. 

- Variable names can be anything with few exceptions( of reserved names) 

- User input- anything that the user types at the keyboard into the programme 

(when running). Otherwise the information is hard coded. 

- Input statement- to store user input. 

Two forms eg  

1. print “ what is your name” 

 input name $ 

 print “       “ name $ 

 

  or 2. input “ what is your name ?”; name $ 

   print “                   “ ; name $ 

 

- The input statement, like the print statement lets your display information to the 

run on the screen. 

Loops 

� if you want to do something over and over again you could just repeat the same 

code a number of times. However this is inefficient and wastes time. 

� Liberty basic uses two types of loops (for loops and while lops) 

For loops(each time through the loop is iteration) 

Use a counter variable. a counter variable is a variable which keeps track of what 

iteration your loop is on. 

- counters –I, J, k. 

How the For  loop works  

-The for loop is given three times: 

1. a variable. 

2. a starting number. 

3. an ending number. 
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You may also include counter steps- look for eg 

 

Eg this program points the number fro 1-10 

For i= 1 to 10   print I next. 

 

6.5  

 

Summary 

In this lecture we have learnt computer programming,  numeric and 

strings, numeric variables, string variables , mathematical 

expressions, assign statement and loops. 

 

6.6  

 

Activity 

Lectures 

Written exercises 

Student presentations 

Class discussions 

Structured laboratory 

Students practice mathematical expression on the computer  and 

solve problems by use of algorithm 

 

6.7 Model Questions 

1. Differentiate numeric from strings .   

2. What is a counter variable? 

3. Explain the specification and syntax and semantics of programming  languages 

6.8 Equipment 

Black board 

Text book 

Handouts 
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6.9 Course Asssessment 

Examination   % Weight   70% 

Course Assessment Test  % Weight   30% 

Total        100%  
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6.10 

References 

R. Clark and L. Wilson (1992), Comparative Programming 
Language (2nd Edition), Addison Wesley 
 
H.E Bal and D Grune (1993), Programming Languages Essential 
M. Ben Ari (1993), John Willey, Understanding Programming 
Languages 
 
A. E. Fischer and Grondzinksky (1993), The Anatomy of 
Programming Language, Prentice Hall 
 
Various applicable manuals and journals. 
 
Variety of electronic information resources as prescribed by the 
lecturer. 
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LESSON SEVEN: APPLICATION SOFTWARE: AWORD PROCESSOR 

Course outline 

7.1 Introduction 

7.2 Lecture Objectives 

7.3 Features of a word processor window 

7.4 Creating, editing, formatting a document 

7.5 Bullets, page numbers, Headers and Footers 

7.6 Printing 

7.7 Summary 

7.8 Activity 

7.9 Model exam questions 

7.10 Suggestions for further reading 

 

7.1 Introduction 

Application Software 

These are programs used to perform specific user tasks such as typing, calculations, 

publishing, drawing , presentation, design and accounting.  Examples are: 

1. Word processors 

2. Spreadsheets 

3. Databases software 

4. Presentation Software 

5. Computer Aided Design (CAD) 

6. Accounting software 

A word processor application window 
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Word Processors 

• A word processor is application software that enables the user to create, save, edit, 

format and print text-rich documents. Examples of common word processors are 

Microsoft ® Word, Corel WordPerfect, Lotus Word Pro and AppleWorks for 

Macintosh. The figure below shows a sample word processor application window. 

Word processors are mainly used to create text-based documents such as mails, CV, 

reports etc. Examples of word processors are: 

1. Microsoft Word 

2. Corel WordPerfect  

3. Lotus Word Pro 

These software have superior text editing and formatting features. 

Spreadsheets 

These are programs used to analyze and manipulate numeric data. The analyzed data can 

be used to generate graphs.  The work area is divided into rows and columns. Examples 

of include: 
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1.  Microsoft Excel 

2. Lotus 1-2-3 

3. Corel Quattro Pro 

 

Databases Software 

Database software commonly referred to as Database management systems (DBMS) are 

used to create and manipulate databases. 

A database is like an electronic cabinet. It is a collection of related data. For example 

UoN database contains of STUDENTS and STAFF databases. 

 

Presentation Software 

These are programs that combines a variety of visual objects to create attractive and 

interesting electronic presentations. 

 

They are excellent tools to communicate and persuade to audience such as potential 

customers. Examples are: 

1. Microsoft PowerPoint 

2. Lotus Freelance Graphics 

3. Corel Presentation 

4. Harvard Graphics  

CAD 

This is a specialized design software used to draw architectural and engineering designs. 

Example is AutoCAD  

 

Accounting Software 

As opposed to Spreadsheets that are more general, Accounting software are specialized 

programs used to analyse financial data. For example, they can be used to generate 

financial statements such trial balance and balance sheets. Examples are: 

Sage 

QuickBooks          
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This lesson will focus on word processor window and the next lesson will address the 

spreadsheets. 

 

 

7.2 Lecture Objectives 

By the end of this lecture,you should be able to: 

1. identify features of a word processor window 

2. learn how to create, edit and format a new document 

3. learn how to insert bullets, page number header and 

footer 

4. learn how to print a document 

 

7.3 Features of a Word Processor Window 

 

 

 
Title bar  

• Title bar indicates the name of the application program in use the currently open 

file, minimize, restore and the close buttons. 

  
Menu bar   

The menu bar provides the user with group of commands in drop down list used to 

create and manipulate a document. 
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Toolbars  

• Toolbars consists of button of commands that provide shortcut to the same 

commands available in the menu bar. 

Document window 

•This is the work area where you create your document. It resembles an ordinary 

piece of paper. 
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Advantages of word processor programs 

 
• Easier to use due to automated features such as Word-wrap, autocorrect and 

autocomplete. 

• They have superior editing tools such as spelling checker, the Thesaurus etc. 

hence making editing easier. 

• Can store documents for future retrieval 

• They have superior formatting features that make a document more appealing to 

• Status bar 

•  The status bar is the communication point between the user and the application 

program. For example in Microsoft Word, when saving a document the status bar 

may indicate “Word is saving ……”. 



 86

 

7.4 Creating, editing, formatting a new document 

• A word processor provides the user with a blank screen in which you enter text or 

graphical objects such as a pictures and drawings. As you type, once you reach the 

end of the current line, the cursor automatically wraps the last word that cannot fit 

the current line to the next line. This is referred to as word wrap. 

• At the end of the page, Word automatically inserts a new page and scrolls up the 

screen. 

• To start Microsoft Word 2003 

• Click start then, point to Programs 

• From the side kick menu, Point to Microsoft Office, then click Microsoft Word 

2003. See figure below 
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Starting word 2003 
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Saving the document 

 

 

Editing a document 

 

 

Editing refers to making necessary changes or modification to an existing document. 

Some editing operations include:  

Delete 

To delete a character, a word or a block of text: 

1.Highlight the text to delete 

2.Press the Delete or the backspace key.  

NB 

Delete key erases characters to the right of the cursor while the backspace deletes 

characters to the right.  

 

• To save a word processor document: 

• From the File menu, click the Save As command or simply click the save 

button. 

• In the Save As dialog box, select the location (drive/folder) from the “Save in” 

list box 

• Type in the name of the file in the File name box 

• Click the save button or press the Enter key 
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Thesaurus 

Thesaurus lets the user automatically find words or phrases with similar meaning 

(synonym) or opposite meaning (antonym) to the selected.  

 

To use thesaurus: 

1. Highlight the text 

2. From Tools menu, Point to Language then click  Thesaurus. 

3. Select a synonym or an antonym 

Spelling and grammar checker 

 

Spelling and grammar checker  lets you automatically locate for misspelled words and 

grammatical problems.  

 

To spell check a document: 

1. From Tools menu click Spelling and Grammar or press F7  

2. In the displayed dialog box, misspelled words are shown in red while 

grammatically incorrect phrases are in green. 

3. From the suggestion list, select the correct spelling or grammar. 

4. Click Change (All) button. To ignore, click the ignore (All) button.  



 90

 

 

 

 

 

 

Find and Replace 

 

This is a feature used to locate for a word or a phrase and replace it with another.  

 

To find and replace a word or phrase:  

1. From Edit menu, click Find or Replace 

2. In the “Find What”  box, type the word or phrase to find.  

3. Click the Replace tab and in the “Replace With” type the word or phrase to 

replace the found word or phrase. 

Autocorrect and AutoText:  

Autocorrect and AutoText make are used to automatically correct a commonly 

misspelled word and  insert a predefined text when creating a document. 

 

 To create an autocorrect or Autotext: 

• From the Insert menu, point to Autotext, then click  AutoText 

command 

• Click the Autotext or Autocorrect tab and type the autocorrect or 

Autotext  

• Click OK to apply and close the dialog box.  
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Undo and Redo  

Undo cancels the last issued command while redo reverts back to the cancelled action.  

 

To undo or redo: 

From the Edit menu, click Undo or Redo alternatively press Ctrl+Z  to Undo, or Ctrl+Y 

to Redo. 

 

Formatting a document  

Formatting refers to enhancing the appearance of a document. You format text, 

paragraphs, page or the entire document. 

 

Text formatting 

You format text by applying different font types, style, size, colour and other attributes.  

 

Applying fonts  

To format text font: 

1. Highlight the text  

2. From the Format menu, click Font 

3. In the font dialog box, select the font type, style, size and colour.  

4. Apply other font attributes then click OK. 

 

 

Text formatting 

 



 92

 
 

Case 

The cases applied to text are; lowercase, UPPERCASE, Sentence case, Title Case and 

tOGGLE cASE. To change case: 

1. Highlight the text  

2. From the Format menu, click Change Case 

3. From change case dialog box, select the case option you want to apply then OK. 

 

NB 

The use of case in this sentence is deliberate. 
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Superscript and Subscript 

A superscript appears just above the rest of the characters as in cm2 while a subscript 

appears just below other characters as in H2O.  

To make text superscript or subscript: 

1. Highlight the character(s) 

2. From the Format menu, click font 

3. From the font dialog box check superscript  or subscript  

 

 

 

 

Paragraph formatting  

A paragraph is a separate block of text dealing with a single theme and starting on a new 

line or indent. Some of the formatting features you can apply onto a paragraph include: 

Case dialog box 
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• Alignment 

• Line spacing 

• Setting tabs & indents 

• Drop cap etc 

 

Alignment 

Alignment is the arrangement of text relative to the left margin, centre of page or the 

right margin. The five major alignment options available are the left, center, right and 

justified and force justified. 

 

To align text: 

1. Highlight the text  

2. From the Format menu, click Paragraph.  

3. In the paragraph dialog box, select the  alignment option from the alignment list box 

then click  the OK. 

 

NB 

You can apply alignment by simply clicking any of the five alignment buttons on the 

formatting toolbar 
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Line spacing 

You can set the space between lines, paragraphs or blocks text.  

 

To space lines: 

1. Highlight the lines of text  

2. From the Format menu, click Paragraph 

3. In the paragraph dialog box, select the line spacing option from the line spacing list 

box then click the OK button.. 

 

Setting tabs and indents 

Paragraph dialog box 
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Tabs refer to definite stops when the tab key is pressed while indenting is moving a 

sentence or a block of text away from the margin using the tab key.   

 

To set tabs and indents: 

1. From the Format menu, click Tabs 

2. In the Tab dialog box, set the tab stop, alignment and leading then click the OK.  

3. Press the Tab key to increase or the Spacebar to decrease the indent. Alternatively, 

click the increase/decrease indent buttons on the formatting toolbar. 

 

 

Drop cap  

A drop cap is a large character in a paragraph that occupies more than one line down. 

 

To create a dropped cap: 

Setting tabs and indents 
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1. Highlight the paragraph you want to begin  with drop cap  

2. From Format menu, click Drop Cap.  

3. Click Dropped or In Margin.  

4. Specify the number of lines and other  options then click OK.  

 

 

 

 

7.5 Bullets, numbering, header, footer  

Bullets and numbers are used to create ordered lists.  

 

To add bullets or numbers to a list: 

1. Highlight the text 

Drop cap 
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2. From the Format menu, click  Bullets and Numbering 

3. From dialog box displayed, click Bullets or Numbered. 

4. Click the bullet or numbering thumbnail you want to apply. 

 

 
 

Inserting columns  

Columns subdivide a page into several vertical sections.  

 

To set columns: 

1. Highlight the text 

2. From the Format menu, click  columns 

3. In the columns dialog box enter the number of columns, set the column width then 

click OK. 

Bullet's and numbers 
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Page and column breaks 

Page, section and column breaks are used to force the cursor to move from a new page, 

section or column even before the end of the current.  

 

To insert a break: 

1. Position the insertion pointer where you want to break 

2. From the insert menu, click Break 

3. In the break dialog box, set the break type then OK. 

 

 

 

Formatting a large document  

Setting breaks 
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Page set up options let you define the paper size, margins and operations.  

 

Page setup 

To set up a page: 

1. From File menu, click Page Setup 

2. In the page setup dialog box, click either of the following: 

• Margins tab to set up page margins 

• Paper tab to specify the paper type and orientation 

• Layout tab to specify the page content layout relative to the margins 

Click OK to apply the settings. 

 

Formatting a large document  

Page set up options let you define the paper size, margins and operations.  

 

Page setup 

To set up a page: 

1. From File menu, click Page Setup 

2. In the page setup dialog box, click either of the following: 

• Margins tab to set up page margins 

• Paper tab to specify the paper type and orientation 

• Layout tab to specify the page content layout relative to the margins 

3.   Click OK to apply the settings. 

 

Page numbers 

Page numbers are used to organize a large document for ease of reference.  

To insert page numbers: 

1. Click Insert then Page Numbers.  

2. In the Position box, specify whether to place the page numbers at the top of page 

(header) or at the bottom of the page (footer).  

3. In the Alignment box, specify whether to align page numbers to the left, center or 

right of page.  
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4. If you don’t want a number on the first page, clear the “Show number on first page” 

check box then click OK. Page numbers are used to organize a large document for 

ease of reference.  

 

To insert page numbers: 

1. Click Insert then Page Numbers.  

2. In the Position box, specify whether to place the page numbers at the top of page 

(header) or at the bottom of the page (footer).  

3. In the Alignment box, specify whether to align page numbers to the left, center or 

right of page.  

4. If you don’t want a number on the first page, clear the “Show number on first page” 

check box then click OK.  

 

Headers and footers 

Headers are lines of text that appears at the top margin of every page or selected pages 

while footers appears at the bottom margin.  

 

To insert a header or footer: 

1. From the View menu, click Header and Footer  

2. To create a header, enter text or graphical object in the header area.  

3. To create footer, click inside the footer area and enter the text or graphical object.  

4. Click Close on the header and footer toolbar.  
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Footnotes and endnotes  

Footnotes and endnotes are used in large documents to explain, comment on, or provide 

references for text in a document. Footnotes appear at the bottom of the page while 

endnote appears at the end of a section or the document.  

 

To insert a footnote or endnote: 

1. From the Insert menu, point to Reference, and then click Footnote.  A dialog box is 

displayed. 

2. In the location section, click Footnotes or Endnotes and specify the location of the 

footnote or endnote 

3. In the Format section, specify the number type, start and continuity 

Headers and footers 
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4. Click Insert.  

 

 

 

 

 

 

 

Inserting graphical objects 

You can insert a graphical object such as a picture, a clip art or drawing on to your 

document.  To insert an object: 

1. On the  Insert  menu point to  Picture .  

2. Click one of the following options 

 • Clip Art  

Footnotes and endnotes 
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 • From File  

 • From Scanner or Camera. 

 • Organization chart, Autoshape, WordArt or Chart. 

2. Depending on the option selected, insert or import the object. 

 

Inserting  special symbols 

A symbol is a special character that is not included on the keyboard such as  Ø, Ù etc: To 

insert a symbol: 

1. Move the text cursor to the position where the new symbol will be 

inserted. 

2. On the insert menu, click Symbol. In the dialog box select the appropriate 

symbol  

3. Click the Insert button then Close. 

 

Password protecting a document  

To protect a document from unauthorized access or modification, use password. Since 

password is case sensitive, avoid mixed case, preferably use lower case. To create a 

password: 

1. On the  Tools  menu, click Options, and then click the  Security  tab.  

2. Type in a password in the Password to open  box or the  Password to 

modify  box         

3. Set other security options then  click  OK.  

 

7.6 Printing a document 

Word processing is not complete without producing a hardcopy. To print a document: 

1. First preview it by clicking  Print preview on the  File menu. 

2. To print, On the File menu click Print 

3. Select the printer, range, number of copies and other options from the dialog box.   

4. Click OK. 

Troubleshooting printing problems 

Some of the printing problems you may encounter are: 
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• Lack of two-way communication due to poor installation of the printer software 

(drivers), if the printer is off or not connected.  

• Paper jams due to use of poor quality of paper or paper folds.  

• Poor quality print due to poor quality ink or toner used.  

 

Summary 

 

The lesson has introduced six major application softwares, namely, 

word processor, Spreadsheets, databases software, presentation 

software, CAD, and accounting software. The lesson has 

concentrated more on the word processor window.  Various 

features and functions of the word processor have been explained.  

Tool bars, status bars, creating and formatting in word processor 

have been demonstrated and practiced.  Students have been led 

through formatting, space setting, inserting bullets and numbering.  

Students have learnt how to create columns , do footnoting and 

print a document. 

 

 

7.7  

 

Activity 

Students practice how to create a new document, correcting 

spellings. page numbering, editing, formatting and printing a 

document  

 

7.8 Model exam questions 

1. Explain how  you can insert the following: 

A header or footer 

Page number 

Columns 

2. How do you set tabs? 

3. State the steps for spacing? 
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4. How do you make text superscripts and subscripts? 

5. List the four steps to go through when printing a document. 

Suggestions for further reading 

1. Date C.J., Kaman, A.S. Swanaynathan 2009. 

An Introduction to Database Systems (8th Ed.) 

Practice  Hall-Pearson 

 

2. Mukhopadhyay, A.K. 2007. 

Microprocessor Microcomputer and Their Applications (3rd Ed) 

Narosa Publishing House Ltd. New Delhi 

 

3. Wyatt Allen L. 1992: 

Windows 3.1, The Pocket Reference: 

Osborne McGraw-Hill, USA 
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LESSON 8: SPREADSHEETS 

Course outline 

8.1 Introduction 

8.2 Lecture Objectives 

8.3 Creation of workbook/worksheet 

8.4 Data editing 

8.5 Data formatting 

8.6 Formulae and Functions 

8.7 Data application and management 

8.8 Charting 

8.9 MS excel 

8.10 Summary 

8.11 Activity 

8.12 Model exam questions 

8.13 Suggestions for further reading 

 

8.1 Introduction 

• A spreadsheet, manual or electronic is a ledger sheet that enables the user to enter, 

edit and manipulate numeric data. An electronic spreadsheet is an automated 

version of the accountant’s ledger. It eliminates the paper, pencil and eraser.  

• Usually, data is organized into rows and columns. 

• The rows are designated by numbers  

 1 – 65556 while the columns are designated by letters A – IV (256 columns).  

 

8.2 Lecture Objectives 

By the end of the course, participants will be able to: 

 

1. Create a workbook/worksheet 

2. Edit data in a worksheet 

3. Format data in a worksheet 

4. Create formulae and use Functions to analyze  worksheet data 
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5. Apply data management on worksheet data 

6. Create charts/graphs 

7. Learn about MS Excel and how to start it 
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8.3 Creating a simple worksheet 

 

Bluechip Communication Ltd 

Summary of  Year 2006  Sales Report 

  Nairobi Kisumu Mombasa Total Sales Average Sales 

January           

February 78000.00 23000.00 67000.00     

March 90000.00 28000.00 56000.00     

April 67000.00 45000.00 56000.00     

May 67000.00 28000.00 45000.00     

June 89000.00 31000.00 45000.00     

July 50000.00 45000.00 78000.00     

August 45000.00 42000.00 54000.00     

September 67500.00 43000.00 56700.00     

October 79000.00 28000.00 65000.00     

November 78000.00 56000.00 45000.00     

December 120000.00 87000.00 97000.00     

            

Yearly Sales           

Minimum  Sale           

Average Sales           

 

Saving your Workbook  

Procedure for saving a newly created workbook 

1. Click File menu 

2. Click Save As from the drop down menu   

 (The Save As dialog box is displayed) 

3. Specify the Save location eg 3½ Floppy A: 

4. Type in the name of the workbook in the filename box 

5. Click the Save button 
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8.4 Data editing 

Editing 

• To edit the contents of a cell,  

• Either click the cell 

• click on the formula bar to type new cell contents 

 Or double click the cell and type in the new cell contents  

NB:  Cell – This is the intersection between a row and a column. 

 

8.5 Data formatting 

Worksheet Formatting 

The purpose of formatting a worksheet is to enhance the appearance of the worksheet and 

to improve the readability of the worksheet data. This includes changing the fonts and 

applying attributes such as borders, patterns colours etc. The formatting toolbar or the 

Format menu is used to apply formatting styles. 

Example: Rotating text 

 Column Labels can be rotated counter-clockwise between 0 to 90 degrees to read 

upwards or clockwise between  

 0 to -90 to read downwards 

 

Procedure   

1. Select the cells containing the data to be rotated 

2. From the format menu, choose cells 

3. Click Alignment tab 

4. In the orientation box, drag the red tipped pointer  up or down to change the 

orientation or specify a value between 90 and -90 in the degrees box. 

5. Click OK 

 

8.6 Formulae Functions 

A mathematical expression that evaluates into a value. It is an instruction to perform 

operations on values. 
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A numeric value (number) that may be used to perform numeric computations 

 

Cell Addresses / Referencing 

A cell address or reference identifies a cell or a range of cells in a worksheet. These 

include the following: 

 

 

Types of cell addresses 

Relative cell referencing 

 The  structure of the formula remains the same when it is copied to other cells but 

the cells change relative to the position of the formula. 

 e.g. Consider the formula =A1+B1 entered in C1. What happens when it is copied 

into B2 through B10?  

 

Absolute cell referencing 

When a formula is copied to other cells, the cell references remain unchanged. A dollar 

sign is placed before the column and the row 

 e.g. $B$20 

 

Mixed cell referencing 

 Either the column or the row is absolutely referenced but not both 

 e.g. $B20, B$20 

 

8.7 Data application and management 

Sorting 

 This means to arrange in a particular order which could be ascending or descending 

order. 

 eg sorting a list of names of students alphabetically or marks in descending order 

from the highest to the lowest. 

 

Filtering 



 112

You can filter data to display only that data that meets a given criteria. This is useful 

when you have a large worksheet and you are interested only in a small portion of it. 

 

Example 

Procedure for filtering data 

1. From the Data menu, choose filter, then Autofilter. 

2. Click Custom 

3. Specify the filter criteria 

4. Click OK 

 

8.8 Charting 

A chart/graph is a graphical representation of the work sheet data and hence shows the 

relationships between values. The choice of the chart depends very much on the kind of 

data you are trying to chart and how you want t present the data. 

 

Creating Charts - Procedure 

1. Select the data 

2. From the Insert menu, choose Chart 

3. Select the type of chart you want 

4. Follow the steps of the Chart Wizard  

 

 

8.9 MS Excel 

Starting Microsoft Excel 

1. Click the Start button 

2. Select Programs/All Programs 

3. Select Microsoft Office 

4. Click Microsoft Excel 

  

The MS Excel window is displayed i.e. a workbook with a number of sheets which can 

be used to enter data. Ms Excel is application software classified under spreadsheets. 
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Terms used in MS excel include worksheet, workbook, columns, rows, column header, 

row header/identifiers, cell, cell pointer, cell selector, cell address, auto fill handle, sheet 

tab, range, formular bar and worksheet selector.  

NB: By default, a typical workbook consists of three sheets labeled Sheet 1, Sheet 2, Sheet 

3 
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Excel application window 

 

 

Title bar  

Name of the application and the current workbook 

 

Menu bar  

A list of menu options containing various commands to work with. 

 

Standard toolbar 

Icons that provide shortcuts to commands 

 

 

Formatting toolbar 

Used to format contents of cells in a worksheet. 
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Formula bar 

Displays the contents of the active cell including formulas and functions. 

 

Name box 

Displays the active cell, i.e. cell with a dark outline that indicates where data in the 

formula bar will be inserted. 

 

Work Area/worksheet 

Blank area made up of rows and columns which holds data 

 

Status bar 

The communication channel between the user and the program indicates messages such 

us Ready, Saving etc 

 

Data entry into a cell 

A cell can hold any of the following: 

Label 

This is any text typed into a cell such as Names, place 

 

Value 

8.10 

 

Summary 

Spreadsheetsis a program used for manipulation of numeric data, 

performing numerous calculations and presenting numerical data 

graphically.  Spreadsheets are used to prepare students’ progress, 

personal budget, business stock and employees payroll. 

In addition to neatness, electronic spreadsheets have the following 

advantages: 

1. Numeric data can be edited and manipulated easily ie one 

can play about with figures. 

2. A large virtual sheet for data entry and manipulation. 256 
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columns X 65556 rows compared to 51 X 30 manual 

ledger sheet 

3. Enhanced formatting capabilities. 

4. Built-in functions which enable the user to create powerful 

mathematical formulae. 

5. Automatic recalculation – The result of a given formula 

auto-adjusts when a value used in formula is changed.  

 

Examples of Spreadsheet Applications 

• Microsoft Excel 

• Quattro Pro 

• Lotus 1-2-3 

• VisiCalc 

 

8.11 

 

Activity 

 
Students practice creating identical sheets in the same work sheet 

file.  They practice inserting worksheet, charting, sorting data, 

finding records, application of Excel and getting data (an argument) 

to work on and use in functions. 

 

8.12 Model Exam Questions 

1. Define the following concepts: worksheet, columns, cell, sheet tab formular Bar 

2. Define freezing panes and list steps 

3. How do you enter a formular? 

4. What is relative referencing? 

5  What steps are used to find records? 

6. List and explain the 3 function categories. 

7. Give steps for sorting data. 

8. How do you enhance worksheet appearance? 
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8.13  
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LECTURE  9.0 INTERACTIVE COMPUTING AND NETWORK 

9.1 Introduction 

9.2 Lecture Objectives 

9.3 Types of  Computer Networks 

9.4 Advantages of having University Network 

9.5 Disadvantages of Installing University Network 

9.6 Network Resources 

9.7 Summary 

9.8 Activity 

9.9 Model Exam Questions 

9.10 Suggestion for further reading 

 

9.1 Introduction 

Computer network is the means of making several computers work together.  Computer 

Network is made possible when several computers are linked together over telephone 

lines through wires and cords and or through radio or electromagnetic waves. 

A network therefore, consists of two or more computers that are joined in order to share 

resources (such as printers and CD-ROMs), exchange files, or allow electronic 

communications. The computers on a network may be linked through cables, telephone 

lines, radio waves, satellites, or infrared light beams. 

 

9.2 Course Objectives 

At the end of the lecture, you will be able to: 

1. Define and discuss the different types of Networks 

2. Assess the advantages and disadvantages of installing a Network in an institution 

3. identify network resources necessary for communication networks. 

 

9.3 Types of Computer Networks 

The basic types of networks include:  
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Local Area Network 

A Local Area Network (LAN) is a network that is confined to a relatively small area. It 

is generally limited to a geographic area such as a writing lab, school, or building. 

Rarely are LAN computers more than a mile apart. In a typical LAN configuration, one 

computer is designated as the file server. It stores all of the software that controls the 

network, as well as the software that can be shared by the computers attached to the 

network. Computers connected to the file server are called workstations. The 

workstations can be less powerful than the file server, and they may have additional 

software on their hard drives. On most LANs, cables are used to connect the network 

interface cards in each computer.  

 

Wide Area Network 

Wide Area Networks (WANs) connect larger geographic areas, such as Nairobi, the 

Kenya, or the world. Dedicated transoceanic cabling or satellite uplinks may be used to 

connect this type of network.  

Using a WAN, learning institutions in Nairobi can communicate with places like Tokyo 

in a matter of minutes, without paying enormous phone bills. A WAN is complicated. It 

uses multiplexers to connect local and metropolitan networks to global communications 

networks like the Internet. To users, however, a WAN will not appear to be much 

different than a LAN or a MAN.  

 

9.4 Advantages of Installing University Network 

Speed. Networks provide a very rapid method for sharing and transferring files. Without 

a network, files are shared by copying them to floppy disks, then carrying or sending the 

disks from one computer to another. This method of transferring files (referred to as 

sneaker-net) is very time-consuming.  

Cost. Networkable versions of many popular software programs are available at 

considerable savings when compared to buying individually licensed copies. Besides 

monetary savings, sharing a program on a network allows for easier upgrading of the 

program. The changes have to be done only once, on the file server, instead of on all the 

individual workstations.  
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Security. Files and programs on a network can be designated as "copy inhibit," so that 

you do not have to worry about illegal copying of programs. Also, passwords can be 

established for specific directories to restrict access to authorized users.  

Centralized Software Management. One of the greatest benefits of installing a network 

at a school is the fact that all of the software can be loaded on one computer (the file 

server). This eliminates that need to spend time and energy installing updates and 

tracking files on independent computers throughout the building.  

Resource Sharing. Sharing resources is another area in which a network exceeds stand-

alone computers. Most schools cannot afford enough laser printers, fax machines, 

modems, scanners, and CD-ROM players for each computer. However, if these or 

similar peripherals are added to a network, they can be shared by many users.  

Electronic Mail. The presence of a network provides the hardware necessary to install an 

e-mail system. E-mail aids in personal and professional communication for all school 

personnel, and it facilitates the dissemination of general information to the entire school 

staff. Electronic mail on a LAN can enable students to communicate with teachers and 

peers at their own school. If the LAN is connected to the Internet, students can 

communicate with others throughout the world.  

Flexible Access. School networks allow students to access their files from computers 

throughout the school. Students can begin an assignment in their classroom, save part of 

it on a public access area of the network, then go to the media center after school to 

finish their work. Students can also work cooperatively through the network.  

Workgroup Computing. Workgroup software (such as Microsoft BackOffice) allows 

many users to work on a document or project concurrently. For example, educators 

located at various schools within a county could simultaneously contribute their ideas 

about new curriculum standards to the same document and spreadsheets.  

 

9.5 Disadvantages of Installing University Network 

Expensive to Install. Although a network will generally save money over time, the initial 

costs of installation can be prohibitive. Cables, network cards, and software are 

expensive, and the installation may require the services of a technician.  
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Requires Administrative Time. Proper maintenance of a network requires considerable 

time and expertise. Many schools have installed a network, only to find that they did not 

budget for the necessary administrative support.  

File Server May Fail. Although a file server is no more susceptible to failure than any 

other computer, when the files server "goes down," the entire network may come to a 

halt. When this happens, the entire school may lose access to necessary programs and 

files. 

9.6 Network Resources 

Telecommunications networks like the Internet, intranets, and extranets have become 

essential to the successful operations of all types of organizations and their computer-

based information systems. Telecommunications networks consist of computers, 

communications processors, and other devices interconnected by communications media 

and controlled by communications software. The concept of network resources 

emphasizes that communications networks are a fundamental resource component of all 

information systems. Network resources include: 

Communications media (twisted-pair wire, coaxial cable, fiber-optic cable, 

microwave systems, and communications satellite systems. 

Network support (people, hardware, software, and data resources that directly 

support the operation and use of a communications network). 

 

9.7 Summary 

Summary 

 

In this lecture, computer network has been defined and advantages and 

disadvantages of installing a network in an institution assessed.  The LAN, 

WAN, MAN and INTERNET have been identified as types of computer 

networks.  Ways computer networking helps in communication, 

teleconferencing resource sharing and conservation have equally been 

addressed. 

9.8 Activity 
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Activity 

 
Students practice linking computers to access the internet. E-mail access, 

sharing printer, softwares, writing letters to each other and downloading 

information sent through linked computers are practiced.  

 

 

9.9 Model Questions 

1.  What is computer Network? 

2. How are computers linked to each other? 

3. What are the benefits of a Computer Network? 

 

4. Decode the following acronyms: 

LAN___________________________________________ 

WAN___________________________________________ 

MAN___________________________________________ 

INTERNET___________________________________ 

 

9.10 Suggestions for further readings 

References 

1. Timothy J.O’Leary and Linda I.O”Leary 2010. 

Computing Essentials, Introductory 

The McGrawHill Companies Inc. 

2. Stallings, William 2009. 

Operating Systems: Internals and Design Principles  

(6th Ed) Prentice-Hall-Pearson 
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LECTURE 10.0:  PROGRAM, PROGRAMMING AND PROGRAMMING 

LANGUAGE 

Course Outline 

10.1 Introduction 

10.2 Lecture Objectives 

10.3 Definition of computer(programming)language 

10.4 Types/levels of computer(programming) languages 

10.5 Basic, C, Cobol, Fortran,Pascal languages 

10.6 Summary 

10.7 Activity 

10.8 Model Questions 

10.9 Suggestions for further readings 

 

10.1 Introduction 

The lesson introduces the meaning of language by referring to ways human beings talk to 

one another using human languages.  In the same respect we instruct computers by 

adopting computer language (s).  That is , the language programmers use in instructing 

the computer is known as programming language.  Computer (programming) language is 

therefore the means of communicating, instructing or talking with computers and 

between computers.  The lesson then introduces and gives a brief  explanation of Basic, 

C, Cobol, Fortran and Pascal as some of the major computer languages. 

 

10.2 Lecture Objectives 

By the end of this lecture will be able to: 

1. Define the concept “computer language” and levels of grouping 

2. Discuss  Basic, “C”, Cobol , Fortran , Pascal languages. 

 

10.3 Definition 

Computer language is the means of instructing and communicating with the computer.  

Programming is the act of writing the set of instructions to operate the computer.  And 

those who engage in programming as their job are known as programmers all over the 
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world.  The language programmers use in instructing the computer is known as 

Programming Language.  Computer (programming) Languages are broken into: 

1. Special –purpose languages    e.g. Lisp, Prolog. 

2. General-purpose languages    e.g. BASIC, Pascal 

3. Scientific-purpose languages e.g. Fortran, APL 

4. Commercial-purpose languages e.g. COBOL, RPG 

5. Educational-oriented languages e.g. Logo, Algol. 

6. Fourth-Generation languages e.g.  dBASE, Foxpro. 

 

10.4 Types/Levels of Computer( programming) Languages 

Primarily, computer languages are broken down into two groups namely:     

1. Low Level Languages:  This group includes-(i)  Machine-language and (ii)  

Assembly Languages. These languages are highly dependent on the machines that run 

them 

 

2. High Level Languages:  This group includes 

(i) General-purpose language  

(ii) Commercial-purpose language 

(iii) Educational language  

(iv) Special–purpose languages. 

 

10.5 High Level Languages 

BASIC 

BASIC   Means Beginner’s All-purpose Symbolic Instruction Code.  It was developed 

by John Kemeny and Thomas Kurtz in early 1960s at Darmouth College, USA. 

 

C 

C is the computer scientists’ language. It is an improvement over B computer language, 

which is an improvement over BCPL computer language.  BCPL means Bell Computer 

Programming Language.  It was developed by Dennis Ritchie of Bell Laboratories, AT & 
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T, USA in   1972.  C is the most powerful and efficient of all high-level computer 

languages. 

 

 

COBOL 

COBOL stands for Common Business Oriented Languages.  It was developed by 

CODASYL (i.e Conference On Data t was developed by CODASYL (i.e Conference On 

Data System Languages) committee in 1959/1960 led by Grace Hopper. 

 

FORTRAN 

FORTRAN is short for FORmula TRANslator.  It is specifically meant for Scientists and 

Engineers who do complex calculations.  It was developed by IBM team led by John 

Baikus in 1956. 

 

PASCAL 

PASCAL is another computer language named after a renowned mathematician, Blaise 

Pascal.  It was developed by nicklaus Wirth in 1971. 

 

There are several other computer languages-e.g. Forth, Prolog, Lisp, Modula etc. 

 

10.6  

 

Summary 

In this lesson, we have learnt the basic meaning of language as used 

by human beings and the language as used by computers for 

communicating among and between computers. We have seen the 

six categories in which computer programming languages are 

broken into and the two groups computer languages are broken 

into, namely the low-level languages and the high-level languages.  

Some high level languages have been discussed with emphasis on 

Basic, C, Cobol, Fortran and Pascal. 
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10.7  

Activity 

Students practice using English languages to communicate to each 

other.  They do class exercises on the various computer languages 

discussed and draw tables to fill in the languages, developers of the 

language and the purpose of development. 

 

10.8 Model Exam Questions 

3. What is computer program? 

4. What is a Programming? 

5. Give an example of each of the following: 

General-purpose language 

Education-oriented language 

Fourth Generation language 

4 Who is a Programmer? 

5 List the classes of  Programming language available. 

6 What is a computer language? 

7 List the groupings of computer language in detail? 

8 Gives names of developers, year of development, and purpose of development of 

the following languages: Basic, C, Cobol, and Pascal. 
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LECTURE11.0: ROLE OF COMPUTER IN AGRICULTURE 

Course outline 

11.1 Introduction 

11.2 Lecture Objectives 

11.3 ICT in Agriculture 

11.4 Application of computers in Agriculture 

11.5 Factors influencing farmers’ computer use 

11.6 Summary 

11.7 Activity 

11.6 Model exam questions 

11.7 Suggestions for further readings 

 

11.1 Introduction  

It is used in record keeping, fertilizer application, determining which crops to plant to 

make a maximum of profit, and determine what and how much medication to give 

livestock. In dairy farming it is used to give the exact amount of feed to each cow based 

on the amount milk the cow gives. You could determine when to market your products to 

give you the best advantage. The uses of computers in agriculture are too many ti list 

each one, but the difference between profit or loss is so close in agriculture that the 

computer can make the difference in success of failure. 

 

11.2: Lecture Objectives 

By the end of this lecture, you will be able to: 

1. Discuss the role of ICT in agriculture 

2. Describe the application of computers in agriculture 

3. Identify factors influencing rs’ computer use 

 

11.3: ICT in Agriculture 

• Farming methods traditionally passed from one generation to next. 

• Neighbouring farmers also help each other on farming tips and hits. 
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• Over years land, rivers, soil, forests have changed for worse as more and more 

people live off same piece of land. 

• Farmers therefore need information for best results from their hard work. 

• Small-scale farmers need to work together to share ideas and resources. 

• Many of them have started using various forms of communication technology to 

keep in touch. 

• Radio a popular method of communicating and distributing agricultural 

information for years  

• Radio medium  advice reach remote farmers at less cost but listeners do not 

interact with radio to share views over airwaves 

• African farm radio research initiatives (AFRRI) seeks ways to involve  farmers 

and communities is making radio program 

• AFRRI project is a test on use of ICTS to gather information from farmers and 

agricultural experts 

• Small inexpensive MP3 players are used by broadcasters to record interviews 

with farmers  

• Radio stations  broadcasts these interviews to wider community enabling farmers 

to learn from each other 

• Experts give their views and solutions to the farmers’ concerns and expert advice 

is broadcast to all farmers 

• AFRI radio stations are experimenting on receiving feedback from listeners via 

mobile phone- farmers call or send sms messages 

• The video recordings  are saved onto CDs or DVDs and distributed to other 

centers. 

• Huge distances between districts call for use of internet, email and radio as they 

also support extension and agricultural agencies. 

• Farmers need regular exchange of information for business new areas, better 

results, access markets, new methods of food processing,storage etc.. 

• Information is now available as everyone is just a phone call away  
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• Development of local content- local languages/farmers to develop own demand-

driven content to increase their bargain and purchasing power  

• Language and cultural identity- vehicle communities use to communicate and 

identify themselves with appropriate technology – Assess what farmers require 

and provide what they really need.  If mobile give them that and not expensive 

computer 

• Approach to using ICTs should focus on people, understanding local reality and 

context, listening to needs of rural communities.  . 

• Technology has potential to enhance opportunities, provide security and play role 

in the economic social and political fabric of all societies. 

11.4: Application of computers in agriculture 

Agriculture is a vast industry that includes plant and animal production, comprehensive 

support and infrastructure systems, and food and fiber processing. Key application areas 

of computers in agriculture include record keeping, decision-making, control, and 

research. 

 

Record-keeping 

a. Recordkeeping is vital in any business.  

b. Agricultural enterprises use computers for common financial and business tasks 

such as inventory, payroll, accounting, and taxes.  

c. There are many differences between agricultural businesses and other businesses 

(with regard to tax structure, labour management, insurance, and inventory, for 

example), software packages have been tailored specifically for agriculture. 

Spreadsheet and database templates are common, but specific application 

programs also exist. 

d. Livestock and crop production farms have unique needs for records. For example, 

crop production fields have numerous descriptors and variables that should be 

recorded (e.g., soil type, drainage, slope, pH, nutrient status); databases have been 

developed to deal with this information.  

e. Precision agriculture (sometimes called site-specific farming) requires such data 

to be recorded not only for fields, but for locations within fields.  
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f. Because they provide a combination of database and drawing functions, 

Geographic Information Systems (GIS) are needed to handle the large amount of 

data.  

g. Global Positioning Systems (GPSs) work with computerized machinery in the 

field to correlate crop and soil conditions with exact locations on the Earth's 

surface. Because soil and crop conditions can vary tremendously within fields, 

this capability can improve the environmental friendliness of farming and 

improve profitability. 

 

h. Similarly, livestock farms track individual animals, storing and evaluating 

information such as age, growth rate, milk production, health records, offspring 

productivity, and reproductive cycle status.  

i. Unlike with large corporations that employ computer scientists, farmers generally 

do not have or cannot hire the expertise to customize relevant software; therefore, 

there is a market for software products suitable for those who are mostly novice 

computer users. 

 

Decision-Making 

Computers can be used to assist agricultural decision-making through such tools and 

techniques as optimization, simulation, fuzzy logic, expert systems, and computer aided 

drafting (CAD).  

A common problem to be solved on crop farms is the selection of the optimal field 

machinery set.  

Proper equipment should be chosen in order to cut on farms costs and time consumed on 

farm operations.  

The equipment must function as an interdependent set; operations must flow in a 

sequential and timely manner. Simulations can model farm and machine events over time 

to predict what would happen if particular machinery sets were chosen. Important factors 

include weather, soil type, and desired field operations.  
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In poultry and livestock production, a major cost of production is feed, often exceeding 

35 percent of gross receipts.  

Landscape design and construction, which is also an agriculture-related enterprise, can 

benefit from computer aided drafting and drawing packages that help designers generate 

and illustrate concepts to clients. By providing projection of individual plant growth, 

good packages can show how plants on a site will look years after installation. 

 

Control 

Control of machinery by computers can provide consistency and reliability unmatched 

with human operation. Controller area networks (CANs) are common on tractors and 

self-propelled equipment; these CANs reduce wiring complexity and allow one or more 

on-board chips to control machine functions such as engine controls, transmission, and 

hydraulic power output.  

Computers are used increasingly to control seeding or chemical application rate 

automatically in fields. 

Research 

Research in agriculture requires some uses of computers not used in other aspects of 

agricultural work. Very sophisticated simulation models address issues such as crop 

growth, animal nutrition, water flow in soil, thermal and physical behavior of agricultural 

products, machinery performance, and integrated farm systems. 

As with most areas of research, good agricultural research requires computers for 

statistical analysis of data, generation of mathematical models, and control of research 

devices. Instrumentation to measure temperature, flow, pressure, electrical conductivity, 

and strain also requires computers or data loggers. 

 

11.5 Factors Influencing Farmers' Computer Use?  

Complexity of Farm - Two aspects of this factor oppose one another. On the one hand, 

the more complicated the farm, the more necessary it would seem for a data storage and 

retrieval system.  

Degree of External Support - Feed companies figure rations. The Dairy Herd 

Improvement Association keeps dairy records. Private firms offer computerized 
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accounting printouts through farm management services. Many banks also offer financial 

record keeping. Agronomists may keep crop records, veterinarians record herd 

information, and accountants store tax records. Many farmers subscribe to terminals that 

display up-to-the-minute market news and advice. This shows just how much farmers 

really need to use computers. 

Age: "You can't teach an old dog new tricks." Many farmers actually believe this old saw. 

Over and over, we heard statements about age from those who ran into difficulty learning 

to use the computer. "I'm too old to learn." "I'll leave it to my son. He's got computers in 

school." "It's up to the younger generation." Though we met older farmers who were 

using computers, this excuse appeared even among men in their 30s.  

Views on Management: Through talking with and observing farmers, we noticed what 

might be an inconsistency. When asked, most of those interviewed affirmed the need for 

better farm management to increase farm profitability. Actions often belie this 

conviction, however. The implicit view was "the more you work, the bigger the farm, the 

more you make." Management activities were often given low priority. Indeed, fear was 

expressed more than once that management activities involving the computer take too 

much time from important outdoor activities, and thus are perceived as reducing profits. 

These sentiments seem exacerbated by a distaste for management activities.  

Time: Of course, some of the problems with management activities involve legitimate 

time concerns. Cows must be milked, the fields cultivated, rations mixed, and hay put up. 

Data entry and software learning, on the other hand, can be put off. The single biggest 

hurdle in computer use is learning and configuring software. The time required for this is 

substantial. And repeatedly, we heard there just wasn't the block of time on the farm to sit 

down for an extended period to learn. As one farmer put it, "There just weren't any bad 

days last winter."  

Experience: The successes and difficulties encountered by each individual farmer in 

using his/her computer determine to some extent how often the equipment is turned on. If 

a farmer's first software package didn't do what it claimed to, or if the documentation was 

bad, he/she may dismiss computing altogether. The farmer invests considerable money in 

software and is unhappy if it doesn't meet often-inflated expectations. Many computers 



 133

seem to be sitting unused for this very reason, especially those purchased five or more 

years ago.  

Network: Each farm is unique. Each farmer perceives different needs. Those in this study 

found general classes on computers of little help because they didn't relate specifically to 

their needs. Ultimately, the farmer must resort to an individualized approach to learning 

about computer use. One farmer said, "You have to slug it out on your own."  

One factor determining who wins the fight is the number of contacts and sources of 

information readily available to the individual. Those who know a number of others using 

computers in similar ways were much more likely to use their computers extensively. 

Software companies offering support helped tremendously. There's nothing like being 

able to pick up the phone and talk with a friendly voice when you hit a snag.  

Availability of Information: Drought in Kenya not only refers to lack of rain. Lack of 

information on computers and agricultural software also fits the description. Few kind 

words were reserved for computer dealers who wanted to sell hardware to farmers, but 

knew nothing about agricultural software. Brochures come in the mail about this software 

package or that. Costs, however, are high and expert reviews are rarely found. The shops 

sell many computer magazines, but do you think they mention agriculture? Several 

farmers asked about information we had on software and what we thought of this piece or 

that.  

Personality and Approach to Learning: As one might expect, several individuals were 

enthusiastic about their computers. They'd carefully researched their purchases. They'd 

taken the initiative to dig out information from anybody they could find who would talk 

with them. They'd sought out obscure farm computing magazines. They'd gravitated 

toward others who used computers both in agriculture and otherwise. They sought new 

ways to put their computer to work. These people seemed to have unique learning skills 

and personalities that allowed them to maximize those skills. 
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11.6  

 

Summary 

We have discussed various types of  ICT that are likely to be used 

in agriculture, some of which are used in Sub-Saharan-African.  

The radio, MP3, videorecordings, cd, DVDs are some of the ICTs 

discussed.  We then focused on a speficic type of ICT, the 

computer and examined its application in agriculture..  The role of 

the computers in record-keeping, decision-making, control, 

research have been emphasized.  Factors influencing farmers’ 

computer use have also been discussed and these include age, 

experience, type of farm, management style, time, network and 

availability of information. 

 

 

11.7  Activity 

Group discussion and students practice on the computers how they 
can send information to farmers through e-mail.  Use of video 
recordings of information to farmers is practiced and so is the use of 
DVDs.  Students sit in groups listening to information from the radio 
and thus learn how the radio can be effective in informing farmers on 
new development in agriculture. 

 

11.7 Model exam questions 

1. List discuss ten types of ICT you can suggest to farmers for    use in getting 

information on farming. 

2. How can the CD and video be used in farming to get information to farmers?  

3. List and discuss  application of computers in agriculture. 

4. What factors influencing farmers’ computer use? 
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11.9 Suggestion for further readings 

References 

 

1 Okello, Julius J., O. Kirui, G. Njiraini, Z. Gitonga. 2012 

Journal of Agricultural Science, Vol. 4 No.2 February 

2012 

 

2. Irina S., Moira B, Kiesler S. and R. Kraut, 2010. 

“Technology Adoption and use in the Aftermath of hurrican 

Katrina in New Orleans“ American Behavioral Scientist: 

vol. 53;1228 

 

3. Eric Gaduno, (2004).  South African University 

Technology Transfer: 

A comparative Analysis 

 
 

 



 136

LESSON 12.0:  COMPUTER VIRUSES 

12.1 Introduction 

12.2 Lecture Objectives 

12.3 Signs of viruses.  

12.4 Summary 

12.5 Activity 

12.6 Model exam questions 

 

12.1 Introduction 

� Computer viruses are small software programs that are designed to spread from 

one computer to another and to interfere with computer operation.  

� A virus might corrupt or delete data on your computer, use your e-mail program 

to spread itself to other computers, or even erase everything on your hard disk.  

� Viruses are most easily spread by attachments in e-mail messages or instant 

messaging messages. That is why it is essential that you never open e-mail 

attachments unless you know who it's from and you are expecting it. 

� Viruses can be disguised as attachments of funny images, greeting cards, or audio 

and video files. 

� Viruses also spread through downloads on the Internet. They can be hidden in 

illicit software or other files or programs you might download. 

 

12.2 Lecture Objectives 

12.3 Signs of viruses.  

Here are a few primary indicators that your computer might be infected: 

1. Your computer runs more slowly than normal  

2. Your computer stops responding or locks up often  

3. Your computer crashes and restarts every few minutes  

4. Your computer restarts on its own and then fails to run normally  

5. Applications on your computer don't work correctly  

6. Disks or disk drives are inaccessible 

7. You can't print correctly  
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8. You see unusual error messages  

9. You see distorted menus and dialog boxes 

These are common signs of infection—but they might also indicate hardware or software 

problems that have nothing to do with a virus. 

 

 

 

12.4   Summary 

In this lecture students have learnt the definition of computer 

viruses and how they can destroy your data and how they spread. 

Students have been exposed to the indicators of viruses that show if 

a computer may be infected. 

 

 

12.5   Activity 

Students learn how anti viruses are installed in a computer and how 

viruses are detected in the computer. 

 

 

12.6 Model exam questions 

1. Define a computer virus? 

2. Give as many signs of computer viruses as possible? 

3. How does virus enter a computers? 

4. How can you get ride of viruses from infecting your computer? 

 

13.0 AWARDING OF MARKS AND GRADING SYSTEM: 

           Continuous assessment and final examination shall be awarded marks as             

            follows: 

                         Continuous Assessment                                  30%  

                          Final Examination                                           70% 

                           Total                                                               100% 

Marks should be translated into the following letter grades: 

                            70%   and above         A          Distinction 
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                            60%--------69%           B           Credit 

                             50%-------59%            C           Satisfaction 

                              40%-------49%            D            Pass 

                              39%-and below            F             Fail 

The passmark shall be 40% of the full mark (100%).                                                                 

 

 

 

BACK PAGE 

 

The motivation for readers of this book is to develop capacity in applying ICT 

technologies, particularly the computer as one of  the  modern tools of technology.  To 

achieve innovations and e-learning outcomes, model ICT for agricultural solutions  and 

agricultural technologies the book has exhaustively described software, hardware and 

networks, information processing,, file sorting/merging/structure/organization/ and 

database management.  Application of software and use of packages, operating systems, 

databases, spreadsheets, statistical packages and networking-communication are given a 

wide  coverage. 
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